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INTRODUCTION

This document describes how to install the printer drivers and printer description files for the 
Xerox EX8002 Print Server, Powered by Fiery, set up the EX8002 for printing, and print from 
Apple Mac OS and Microsoft Windows computers. It also provides information about the 
EX8002 print options and describes several printing methods that can be used to print to the 
EX8002. 

For information about setting up network servers and clients to use the EX8002, see 
Configuration and Setup. For general information about using the color digital press, your 
computer, application software, or network, see the documentation that accompanies 
those products.

For information about supported operating systems and system requirements, see Welcome.

Terminology and conventions
This document uses the following terminology and conventions.

Term or convention Refers to

Aero EX8002 (in illustrations and examples)

Digital press DocuColor 8002/7002 digital press

EX8002 Xerox EX8002 Print Server, Powered by Fiery

Titles in italics Other documents in this set

Mac OS Mac OS X

Windows Windows 2000, Windows XP, Windows Vista, 
Windows Server 2003, Windows Server 2008

Topics for which additional information is available by starting 
Help in the software

Tips and information

Important information

Important information about issues that can result in physical 
harm to you or others
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About this document
This document covers the following topics:

• Installing printer files on Mac OS computers

• Setting up the EX8002 for printing from Mac OS computers

• Printing from Mac OS computers

• Installing printer files on Windows computers

• Setting up the printing connections on Windows computers

• Printing from Windows computers

• EX8002 print options

• Using other printing methods to print to the EX8002
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User software
The following table lists the user software that is described in this document. This is the user 
software you need for setting up basic printing on the EX8002. Other documents may 
describe other user software depending on what you are trying to accomplish. 

When you install user software on a Windows computer, you use the Fiery User Software 
Installer. 

System requirements
For detailed system requirements, see Welcome, provided in your media pack.

User software Description

PostScript Printer Description 
(PPD) file and associated files
(for Windows)

Files that provide information about the EX8002 and your particular 
digital press model to your application and printer driver.

PostScript Printer Description 
(PPD/Plugin) files
(for Mac OS X)

Files used with the PostScript printer driver that allow the EX8002 
to appear in the Print and Page Setup dialog boxes of popular 
applications. The EX8002 PPDs provide information about the 
digital press to your application and printer driver.

PageMaker PPD files Files that allow you to print to the EX8002 from Adobe PageMaker. 
You must install the appropriate PPD in PageMaker. See the 
PageMaker documentation for instructions.

PostScript screen fonts
(for Mac OS X)

PostScript/TrueType screen fonts that correspond to the printer fonts 
installed on the EX8002. For a complete list of PostScript/TrueType 
fonts installed on the EX8002, print a Font List. For more 
information, see Command WorkStation Help. 

Job Monitor 
(for Windows)

Monitor the status of connected EX8002s and print jobs sent to 
them. Job Monitor is automatically installed when the printer driver 
is installed on a Windows computer.

For more information, see “Configuring and using Job Monitor” on 
page 61.

Printer Delete Utility 
(for Windows)

Uninstall the Windows printer driver. 

For more information, see “Uninstalling printer drivers” on page 43.
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PRINTING FROM MAC OS X

To set up the EX8002 as a PostScript printer on a Mac OS X computer, install the printer 
driver files that correspond to your digital press and set up the EX8002 for printing. Printer 
drivers provide a way to communicate information about print jobs between your 
applications, the EX8002, and the digital press.

For the location of each procedure, see the following table.

Installing the Mac OS X printer files
The Mac OS X printer driver files are provided on the User Software DVD or can be 
downloaded from the EX8002 over the network or using WebTools. The following sections 
describe how to install the printer files for the EX8002.

Installing from the User Software DVD

The User Software DVD provides the following software for Mac OS X (see the OSX:Printer 
Driver folder):

• OSX Installer: Installs the printer driver files required to print from Mac OS X.

• Language folders: Printer description files that are installed by OSX Installer. You do not 
need to open these folders or install them manually on your computer. The appropriate 
files are installed by OSX Installer.

NOTE: The following procedure is for Mac OS X v10.5 and Mac OS X v10.4.x.

Procedure See

Installing the Mac OS X printer files page 10

Setting up the EX8002 for printing page 13

Printing from Mac OS X computers page 21
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TO INSTALL THE PRINTER DRIVER FILES FOR MAC OS X

1 Quit all open applications.

2 Mac OS X v10.4.x: Make sure that the Printer Setup Utility is not running on your computer.

Printer Setup Utility updates the list of available printers when it starts. If a printer description 
file is added while Printer Setup Utility is running, you cannot select the associated printer 
model until you restart.

3 Insert the User Software DVD into the DVD drive.

4 Open the OSX : Printer Driver folder on the User Software DVD.

If you are installing from a folder you downloaded from WebTools or the EX8002, browse to 
the Printer Driver folder on your desktop.

5 Double-click the OSX Installer icon to start installing the printer driver.

6 Follow the on-screen instructions.

The OSX Installer installs the printer driver files that correspond to the EX8002.

7 When copying is complete, click Quit.

Downloading printer drivers using WebTools

WebTools allows you to download installers for printer drivers to your computer directly from 
the EX8002. 

Before you download the printer driver files, the administrator must enable Internet access to 
the EX8002.

For more information about setting up and starting WebTools, see Utilities.
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TO DOWNLOAD PRINTER DRIVERS WITH WEBTOOLS

1 Start your Internet or intranet browser and type the DNS name or IP address of the EX8002.

2 Click the Downloads tab. 

3 Click the link for the printer drivers that you want to install (Printer Files for Mac OS X).

A file named OSX.dmg is downloaded to your desktop. The file contains a folder named 
Printer Driver in a compressed format. If your Internet browser is equipped with an expander 
utility, such as StuffIt Expander, the folder decodes and decompresses automatically.

If the Printer Driver folder does not automatically decode and decompress, double-click the 
file to start the utility that performs that function.

4 Open the OSX : Printer Driver folder.

5 Double-click the OSX Installer icon to start installing the printer driver.

Follow the on-screen instructions.

For instructions on installing the printer driver for Mac OS X, see page 11.

Downloading printer drivers from the EX8002
You can download printer driver files to your computer directly from the EX8002 over the 
network.

TO DOWNLOAD PRINTER DRIVER FILES FROM THE EX8002

1 In the Finder, choose Connect to Server from the Go menu.

2 Type SMB:// followed by the name or IP address of the EX8002 and click Connect.

If you cannot locate your EX8002, contact your administrator.

3 Type the user name and password in the SMB/CIFS File System Authentication dialog box.

The “Guest” account can be used as the default. The Guest account does not require a 
password. If the Guest account cannot be used, ask your network administrator for an 
account.

4 Select the Mac_User_SW folder from the shared volume list and click OK.

5 Open the OSX : Printer Driver folder.

6 Double-click the OSX Installer icon to start installing the printer driver.

Follow the on-screen instructions.

For instructions on installing the printer driver for Mac OS X, see page 11.
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Setting up the EX8002 for printing
The following section describes how to set up the EX8002 on a Mac OS X computer.

NOTE: The steps for setting up the EX8002 on a computer with Mac OS X v10.5 and Mac 
OS X v10.4.x are different. Any differences are noted in the following sections.

Setting up printing with Mac OS X v10.5

Use the following procedures to set up the EX8002 on a computer with Mac OS X v10.5.

TO SET UP THE EX8002 FROM THE PRINT DIALOG BOX

1 Open a file in your application.

2 Choose Print from the File menu.

The Print dialog box appears.

3 Select Add Printer from the Printer list.

In the dialog box that appears, select a printer connection. Use one of the printer connections 
in the following table to add a printer.

TO SET UP THE EX8002 USING PRINT & FAX

1 Choose System Preferences from the Apple menu, and then choose Print & Fax.

The Print & Fax dialog box appears.

2 Click the “+” button to add a printer.

In the dialog box that appears, select a printer connection. Use one of the following 
connections to add a printer.

Printing connection See

Default (Bonjour or AppleTalk) page 14

IP Printer page 15

AppleTalk page 16
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TO ADD A PRINTER WITH THE DEFAULT (BONJOUR OR APPLETALK) CONNECTION

1 Click the Default icon in the dialog box.

The Default pane appears.

The names of printers with default connections are listed. The Virtual Printers that are 
configured at the EX8002 are also listed.

NOTE: The names of the Virtual Printers appear as <printer name:Virtual Printer name> in 
the Printer Name list.

2 Select the EX8002 from the list.

The information about the selected printer appears at the bottom of the Default pane. The 
appropriate PPD file for the EX8002 is automatically selected. If your administrator 
configured the Secure Access printing at the EX8002, the PPD file for Secure Access printing 
is selected.

3 Click Add.

AppleTalk: The EX8002 name appears in the Printer List of the Print & Fax dialog box.

Bonjour: The Installable Options pane in the Print & Fax dialog box appears. Click Continue 
to return to the Print & Fax dialog box. The EX8002 name appears in the Printer List.

4 Choose EX8002 from the Printer List.

5 Click Options & Supplies, and then click the Driver tab.

6 Specify the installable option settings, and then click OK.
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TO ADD A PRINTER WITH THE IP PRINTER CONNECTION

1 Click the IP icon in the dialog box.

The IP pane appears.

2 LPD printing: Select Line Printer Daemon - LPD from the Protocol list, type the EX8002 IP 
address or DNS name in the Address field, and then type the print connection (print, hold or 
direct) in the Queue field. Proceed to step 6.

IP printing: Select Internet Printing Protocol - IPP from the Protocol list and type the EX8002 
IP address or DNS name in the Address field. Proceed to step 3.

The IP address or DNS name appears in the Name field.

3 Type “ipp/” followed by the print connection (print, hold, direct, or name of virtual printer) 
in lowercase letters in the Queue field.

NOTE: The EX8002 requires a queue name. Do not leave the Queue field empty.

4 Choose “Select a driver to use” from the Print Using menu. 

5 Type EX8002 in the search filter to narrow the search, and then select the PPD file from the 
list.

6 Click Add.

The Installable Options pane in the Print & Fax dialog box appears. 

7 Click Continue. 

The EX8002 with its IP address appears in the Printer List.

8 Choose EX8002 from the Printer List.

9 Click Options & Supplies, and then click the Driver tab.

10 Specify the installable option settings, and then click OK.

For information about configuring installable options, see printer driver Help.



PRINTING FROM MAC OS X 16

TO ADD A PRINTER WITH THE APPLETALK CONNECTION

NOTE: Use this procedure if the EX8002 is in a different AppleTalk zone than your computer. 
If the EX8002 is in the same zone, it is displayed as a default following the procedure on 
page 14.

1 Click the AppleTalk icon in the dialog box.

The AppleTalk pane appears.

2 Select the AppleTalk zone for the EX8002 from the list.

The AppleTalk printers in the specified zone are listed. The Virtual Printers that are 
configured at the EX8002 are also listed.

NOTE: The names of the Virtual Printers appear as <printer name:Virtual Printer name> in 
the Name list.

3 Select the EX8002 name in the Printer List and click Add.

The EX8002 name appears in the Printer List of the Print & Fax dialog box.

4 Choose EX8002 from the Printer List.

5 Click Options & Supplies, and then click the Driver tab.

6 Specify the installable option settings, and then click OK.
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Setting up printing with Mac OS X v10.4.x

Use the following procedures to set up the EX8002 on a computer with Mac OS X v10.4.x.

TO SET UP THE EX8002 FROM THE PRINT DIALOG BOX

1 Open a file in your application.

2 Choose Print from the File menu.

The Print dialog box appears.

3 Select the Add Printer from the Printer list.

In the dialog box that appears, select a printer connection. Use one of the printer connections 
in the table below to add a printer.

TO SET UP THE EX8002 USING PRINTER SETUP UTILITY

1 In the Finder, choose Utilities from the Go menu.

2 Start Printer Setup Utility.

The Printer List dialog box appears.

3 Click Add.

In the dialog box that appears, select a printer connection. Use one of the printer connections 
in the following table to add a printer.

TO SET UP THE EX8002 USING PRINT & FAX

1 Choose System Preferences from the Apple menu, and then choose Print & Fax.

The Print & Fax dialog box appears.

2 Click the “+” button to add a printer.

In the dialog box that appears, select a printer connection. Use one of the following 
connections to add a printer.

Printing connection See

Default Browser (Bonjour or AppleTalk) page 18

IP Printer page 19

AppleTalk page 20
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TO ADD A PRINTER WITH THE DEFAULT BROWSER (BONJOUR OR APPLETALK) CONNECTION

NOTE: Bonjour printers are available to Mac OS X v10.4.x computers only if Bonjour is 
enabled on the EX8002.

1 Click Default Browser in the Printer Browser dialog box.

The Default Browser pane appears.

The names of printers with default connections are listed. The Virtual Printers that are 
configured at the EX8002 are also listed.

If the printer is not listed in the Printer Name list, click More Printers.

NOTE: The names of the Virtual Printers appear as <printer name:Virtual Printer name> in 
the Name list.

2 Select the EX8002 from the list.

The information about the selected printer appears at the bottom of the Default Browser 
pane. The appropriate PPD file for the EX8002 is automatically selected.

3 Click Add.

AppleTalk: The EX8002 name appears in the Printer List of the Print & Fax dialog box.

Bonjour: The Installable Options pane in the Printer Browser dialog box appears. Click 
Continue to return to the Print & Fax dialog box. The EX8002 name appears in the Printer 
List.

4 Choose EX8002 from the Printer List and click Show Info. 

5 In the Printer Info dialog box, choose Installable Options, specify the installable option 
settings, and then click Apply Changes. 

6 Close the Printer Info dialog box.
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TO ADD A PRINTER WITH THE IP PRINTER CONNECTION

1 Click IP Printer in the Printer Browser dialog box.

The IP Printer pane appears.

2 LPD printing: Select Line Printer Daemon - LPD from the Protocol list, type the EX8002 IP 
address or DNS name in the Address field, and then type the print connection (print, hold or 
direct) in the Queue field. Proceed to step 6.

IP printing: Select Internet Printing Protocol - IPP from the Protocol list and type the EX8002 
IP address or DNS name in the Address field. Proceed to step 3.

The IP address or DNS name appears in the Name field.

3 Type “ipp/” followed by the print connection (print, hold, direct, or name of virtual printer) 
in lowercase letters in the Queue field.

NOTE: The EX8002 requires a queue name. Do not leave the Queue field empty.

4 Print Using: Choose the appropriate manufacturer name or model, and then select the file for 
the EX8002 PPD. 

5 Click Add.

The Installable Options pane in the Printer Browser dialog box appears. 

6 Click Continue to return to the Print & Fax dialog box. 

The EX8002 with its IP address appears in the Printer List.

7 Choose EX8002 from the Printer List and click Show Info.

8 In the Printer Info dialog box, choose Installable Options, specify the installable option 
settings, and then click Apply Changes. 

For information about configuring installable options, see printer driver Help.

9 Close the Printer Info dialog box.
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TO ADD A PRINTER USING THE APPLETALK CONNECTION

NOTE: Use this procedure if the EX8002 is in a different AppleTalk zone than your computer. 
If the EX8002 is in the same zone, it is displayed as a default following the procedure on 
page 18.

1 Click Default Browser or IP Printer in the Printer Browser dialog box.

2 Click More Printers.

The dialog box with a list of other connections appears.

3 Select AppleTalk from the connection list.

The AppleTalk pane appears.

4 Select the AppleTalk zone for the EX8002 from the list.

The AppleTalk printers in the specified zone are listed. The Virtual Printers that are 
configured at the EX8002 are also listed.

NOTE: The names of the Virtual Printers appear as <printer name:Virtual Printer name> in 
the Name list.

5 Select the EX8002 name in the Name list and click Add.

The EX8002 name appears in the Printer List of the Print & Fax dialog box.

6 Choose EX8002 from the Printer List and click Show Info. 

7 In the Printer Info dialog box, choose Installable Options, specify the installable option 
settings, and then click Apply Changes. 

8 Close the Printer Info dialog box.
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Configuring Installable Options
To use the print options for the digital press and EX8002 appropriately, you must configure 
the EX8002 from your computer for the options that are installed on the digital press. 
Configure the options manually. 

For information about configuring installable options, see printer driver Help.

Using Desktop Printer (optional)

After adding EX8002 to the Printer List in Print & Fax or the Printer Setup Utility, you can 
create and use the Desktop Printer feature.

For information about Desktop Printer feature, see printer driver Help.

Printing from Mac OS X computers
You can print to the EX8002 just as you would print to any other printer from a Mac OS X 
application. Select the EX8002 as the current printer in the Printer List and print the file from 
within the application. In addition to this method, you can download files to the EX8002 
using Hot Folders or the Docs WebTool, and print documents using Command 
WorkStation (see Utilities).

After you install the EX8002 printer driver files using the OSX Installer and set up the 
EX8002 for printing, you can print directly from most Mac OS X applications. Using the 
appropriate PPD file, you can control the EX8002 printing features by specifying print 
options from the Print dialog boxes. For more information about the EX8002 print options, 
see page 70.

To achieve optimal printing results from specific applications, see Color Printing, Fiery Color 
Reference, and Command WorkStation Help.
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Selecting the EX8002 in the Printer List

Before you print a job, you must select the EX8002 from the Printer List. Use the following 
procedure to select the EX8002 as your default printer.

TO SELECT THE EX8002 AS THE DEFAULT PRINTER WITH MAC OS X V10.5

1 Make sure that the EX8002 is connected to the network and turned on.

2 Choose System Preferences from the Apple menu and then choose Print & Fax.

The Print & Fax dialog box appears.

The printers that are set up for printing are listed. The Virtual Printers that are configured at 
the EX8002 and set up for printing are also listed.

3 To make the EX8002 the default printer, select it from the Default Printer menu.

4 Close the window.
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TO SELECT THE EX8002 AS THE DEFAULT PRINTER WITH MAC OS X V10.4.X

1 Make sure that the EX8002 is connected to the network and turned on.

2 In the Finder, choose Utilities from the Go menu.

3 Start Printer Setup Utility.

The Printer List dialog box appears.

The printers that are set up for printing are listed. The Virtual Printers that are configured at 
the EX8002 and set up for printing are also listed.

4 Select the EX8002 in the Printer List to specify it as your current printer.

5 Click the Make Default icon.

The EX8002 is now your default printer.
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Setting print options and printing from Mac OS X applications

In Mac OS X applications, print options are set from the Page Setup dialog box and the Print 
dialog box. For information about specific print options, see Print Options. 

NOTE: Some default print options are set by your administrator during Setup. For information 
about the current server default settings, contact your administrator or the operator.

NOTE: The following procedure uses Mac OS X v10.5 illustrations.

TO SET PRINT OPTIONS AND PRINT FROM MAC OS X

1 Open a file and choose Page Setup from the application’s File menu.

2 For Settings, choose Page Attributes. For Format for, choose the EX8002.

The Paper Size option in the Page Setup dialog box is the same as the Document Size print 
option on the Fiery Features Media tab. Document Size is the page size defined in your 
original application’s Print setup (or Page Setup) dialog box. 

The Paper Size print option on the Fiery Features Media tab is the size of the actual sheet of 
paper on which your job will print. The default value of the actual paper size is the paper size 
set in the Page Setup dialog box. 
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3 Select the Page settings for your print job.

4 Click OK.

5 Choose Print from the application’s File menu.

6 Choose the EX8002 as your printer.

7 Choose Fiery Features from the drop-down list.

NOTE: For information about Two-Way Communication, see page 31.

For information about using presets, see printer driver Help.

1 Fiery Features
2 Customize button
3 Full Properties button
4 Presets
5 Two-Way Communication 1

2

3

4

5
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8 Click Customize to specify the options shown in the Quick Access window.

You can select a shortcut from the Available Shortcuts list and add it to the Current Shortcuts 
list, as well as removing a shortcut from the Current Shortcuts list. Click OK to save your 
changes.

For information about customizing the Quick Access view, see printer driver Help.

9 Click Full Properties in the Quick Access window.

The Job Info tab is displayed in the Printing Preferences dialog box.

10 Type your user name or domain\user name in the User Name field if User Authentication is 
enabled on the EX8002 under User Authentication.

11 Type your local password or domain password in the Password field if User Authentication is 
enabled on the EX8002 under User Authentication.



PRINTING FROM MAC OS X 27

12 Type information in the Notes 1 and Notes 2 fields under Job Notes.

13 Type instructions to the operator about the job in the Instructions field. 

These instructions can be displayed in Command WorkStation but do not appear in the 
Job Log. These instructions can be edited by the operator.

14 Type values for the other fields, as required. 

For information about these fields, see page 70.

15 Click the Color icon.

16 Specify color print options for the job. 
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17 To use advanced color management features, such as Rendering Style, click Expert Settings.

The Expert Color Settings dialog box appears.

NOTE: To display the color settings from the EX8002 in this dialog box, make sure that Two-
Way Communication is selected. For information about enabling Two-Way Communication, 
see printer driver Help.

To set the Output Profile option to Use Media Defined Profile, you must first make sure that 
Two-Way Communication is not enabled, and then you can select Use Media Defined Profile 
from the drop-down list for Output Profile. Enable Two-Way Communication if you want to 
be able to select specific downloaded output profiles.

18 Specify the color settings for the print job and click OK.

Two-Way Communication On
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19 To shift the position of the print image on the page, click the Finishing icon and select Image 
Shift to specify the shift distances.

You might need to shift the print image to allow for binding, for example.

20 To define Mixed Media, click the Media icon and choose Mixed Media.
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21 Choose other printer-specific options.  

These print options are specific to the EX8002 and the digital press. These options override 
settings in EX8002 Printer Setup but can be changed from Command WorkStation.

If you choose Printer’s default, the job prints according to the settings specified in Setup. 

For more information about these options and overrides, see Print Options.

Some print options that are selectable from an application or are provided by Mac OS are 
similar to the print options that are specific to the EX8002 and the digital press. In these 
cases, use the print options specific to the EX8002 and the digital press that appear in the 
Fiery Features menu. The application may not set up the file properly for printing on the 
EX8002, resulting in unexpected finishing, printing errors, or longer processing time. When 
you print to your selected digital press, make sure to clear the Collated check box in the 
Copies & Pages pane of the Mac OS X v10.4 or earlier printer driver or in the main pane of 
the Mac OS X v10.5 printer driver.

If you select an invalid setting or combination of settings when printing a document, no error 
message appears. For example, you may be able to select duplex printing on transparency 
media. Invalid settings and combinations are ignored by the EX8002.

22 Click Print.
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Defining and printing custom page sizes

With custom page sizes, you define the dimensions of a printed page. After you define a 
custom page size, you can use it from within an application without redefining it each time 
you print. When you create custom page sizes, specify Width dimensions to correspond with 
the shorter side of your job and specify Height dimensions to correspond with the longer side 
of your job. Set custom page sizes in this way, regardless of the orientation settings in the 
application.

NOTE: Custom page sizes are not supported with Imposition jobs.

For information about defining and printing custom pages sizes, see printer driver Help.

Viewing the digital press status

If you enabled a TCP/IP network, you can retrieve digital press status and color settings from 
the EX8002 and display them in the printer driver using the Two-Way Communication 
option. The digital press status includes the current paper and toner levels. You can set the 
color settings on the EX8002 using Command WorkStation. For more information about 
color print options, see Color Printing or Command WorkStation Help.

For information about enabling Two-Way Communication, see printer driver Help.

Height

Width

Width

Height

Portrait Landscape
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PRINTING FROM WINDOWS

To set up the EX8002 as a digital press on a Windows computer, install the printer driver files 
that correspond to your digital press and set up the EX8002 for printing. Printer drivers 
provide a way to communicate information about print jobs between your applications, the 
EX8002, and the digital press.

For the location of each procedure, see the following table.

Installing Windows printer drivers
Installing printer drivers and printer description files is the first step in setting up the EX8002 
as a PostScript printer.

You can install printer drivers as follows:

• From the EX8002 through Point and Print using SMB printing.

• From WebTools, using the Downloads tab to download the printer driver files before 
installing the printer driver.

NOTE: WebTools is available if the administrator has enabled Internet access to the EX8002.

• From the EX8002 by downloading the printer driver files over the network before 
installing the printer driver. 

• From the User Software DVD.

NOTE: If the EX8002 printer driver is already installed, you must uninstall it before you install 
a new driver (see “Uninstalling printer drivers” on page 43).

Procedure See

Installing Windows printer drivers page 32

Setting up the EX8002 for printing page 44

Printing from Windows computers page 52
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For the location of each procedure, see the following table.

Installing printer drivers by Point and Print

SMB printing (also known as Windows or WINS printing) allows you to install PostScript 
printer drivers on your computer from the EX8002 using Point and Print, and print to a 
particular connection (Print queue, Hold queue, Direct connection, or virtual printer).

Each connection (print, hold, direct or virtual printer) requires a separate installation. Repeat 
the procedure for each connection.

When you install the printer driver using Point and Print, you cannot configure installable 
options manually. The installed options are displayed as the EX8002 configuration in the 
printer driver. For more information, see “Configuring installable options” on page 51.

BEFORE YOU BEGIN

Ask your administrator to do the following in Setup on the EX8002:

• Assign the EX8002 a valid IP address.

Ask your administrator for the IP address or DNS name required in the following procedure.

• Configure the EX8002 for SMB printing.

NOTE: SMB printing is referred to as Windows Printing in Setup and on the Configuration 
page. 

For more information, see Configuration and Setup or WebTools Configure Help.

Procedure See

Installing printer drivers by Point and Print page 33

Downloading printer drivers using WebTools page 36

Downloading printer drivers from the EX8002 page 37

Installing printer drivers from the User Software DVD page 38

Installing and connecting to a virtual printer page 41

Uninstalling printer drivers page 43
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TO SET UP SMB PRINTING ON WINDOWS COMPUTERS

1 Windows 2000/XP/Server 2003: Right-click Network Neighborhood or My Network Places, and 
select Find Computer or Search for Computers.
Windows Vista/Server 2008: Click the Start button, choose Control Panel, double-click 
Network and Sharing Center, and then click the View computers and devices link.

2 Windows 2000/XP/Server 2003: Type the name or IP address of the EX8002 and click Search 
Now or Search.
Windows Vista: Type the name of the EX8002 in the Search field and click Enter.
Windows Server 2008: Type the name or \\IP address of the EX8002 in the Search field and 
click Enter.

If you cannot locate the EX8002, contact your EX8002 administrator.

3 Double-click the name of the EX8002 to display enabled print connections.

NOTE: For a description of each print connection, see Configuration and Setup.

4 Double-click the connection that you want to set up (print, hold, direct, or virtual printer).

The files are installed on your computer.

NOTE: You may receive a message that you are about to connect to a printer on the EX8002, 
which will automatically install a printer driver on your machine. Click Yes to continue.

5 Windows 2000: Click Start, choose Settings, and then choose Printers. 
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista: Click the Start button, choose Control Panel, and then double-click Printers.
Windows Server 2008: Click the Start button, choose Control Panel, and under Classic View, 
double-click Printers.

The printer is displayed in the Printers or Printers and Faxes window.

6 Right-click the EX8002 icon and choose Properties.

7 Click Print Test Page on the General tab.

If the Test Page prints successfully, you are ready to print from the computer.

8 Repeat the previous steps for the other connections that you want to set up.
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Setting up installable options in printer drivers

To view correct installation options in the Point and Print printer drivers, you must set up the 
EX8002.

TO SET UP THE EX8002 TO VIEW INSTALLABLE OPTIONS

1 Log on to the EX8002 using the Windows XP Remote Desktop.

For information about enabling Remote Desktop, see Configuration and Setup.

2 Right-click the Print queue.

3 Select Properties.

4 Click the Installable Options tab.

5 Verify that the Printer IP address is localhost.

6 Click Update.

7 Click OK to close the Printer Properties dialog box.

8 Repeat steps 2–7 to set up the Hold queue and to set up direct connection printing.

For more information on configuring and setting up the EX8002, see Configuration and 
Setup.
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Downloading printer drivers using WebTools

WebTools allows you to download installers for printer drivers to your computer directly from 
the EX8002.

Download the printer driver files from the EX8002 using WebTools, and then follow the 
procedures on page 38 to install the printer driver. Before you download the printer driver 
files, the administrator must set specific EX8002 options in Setup. You must also prepare each 
client computer to communicate with the EX8002 over the Internet or intranet.

For more information about Setup, see Configuration and Setup.

For more information about setting up and starting WebTools, see Utilities.

TO DOWNLOAD PRINTER DRIVER FILES WITH WEBTOOLS

1 Start your Internet or intranet browser and type the DNS name or IP address of the EX8002.

2 Click the Downloads tab.

3 Click the link for the item that you want to install. 

For Windows printer drivers, click the Printer Files link under the Windows heading.

4 If a dialog box prompts you to open the file or save it to disk, choose to save it 
to disk.

5 Browse to the location where you want to save the PRNTDRVE.EXE file and click Save.

The file is downloaded from the EX8002. This compressed file is an archive that contains 
multiple files.

6 Double-click the PRNTDRVE.EXE file to extract the files.

Depending on your operating system, you might be prompted to select a location to extract 
the files to.

Follow the instructions for your operating system to install the printer driver. The procedures 
are the same as for installing from the DVD, except that after you click Have Disk, you 
browse to the location where you extracted the files, rather than to the DVD.

For instructions on installing the Windows printer driver, see “To install and complete the 
print connection for Windows” on page 38.

For more information, see WebTools Downloads Help.
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Downloading printer drivers from the EX8002

You can download printer drivers files to your computer directly from the EX8002 over the 
network, and then install them following the procedures in “Installing printer drivers from the 
User Software DVD” on page 38.

TO DOWNLOAD PRINTER DRIVER FILES FROM THE EX8002

1 Windows 2000/XP/Server 2003: Right-click Network Neighborhood or My Network Places, and 
select Find Computer or Search for Computers.
Windows Vista/Server 2008: Click Start, choose Control Panel, double-click Network and 
Sharing Center, and then click the View computers and devices link.

2 Windows 2000/XP/Server 2003: Type the name or IP address of the EX8002 and click Search 
Now or Search.
Windows Vista/Server 2008: Type the name or \\IP address of the EX8002 in the Search field 
and click Enter.

If you cannot locate your EX8002, contact your administrator.

3 Double-click the name of the EX8002.

A folder called PC_User_SW is displayed along with the enabled print connections.

4 Double-click the PC_User_SW folder and browse to the English\Prntdrvr\Ps_drvr folder.

Follow the instructions for your operating system to install the printer driver. The procedures 
are the same as for installing from the DVD, except that after you click Have Disk, you 
browse to the Win_2K_XP_VISTA folder on your desktop, rather than to the DVD.
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Installing printer drivers from the User Software DVD

The following procedures describe installing the printer driver from the User Software DVD.

To install the printer driver on a Windows Server 2003/Server 2008 computer, select the same 
PPD (oemsetup.inf ) file as for Windows 2000/XP/Vista, described in the following 
procedure.

NOTE: The following procedures use Windows XP illustrations. 

This procedure describes the installation of a local printer (Port9100). You can modify the 
printing protocol later, according to your network type.

TO INSTALL AND COMPLETE THE PRINT CONNECTION FOR WINDOWS

1 Windows 2000: Click Start, choose Settings, and then choose Printers. 
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista: Click Start, choose Control Panel, and then double-click Printers.
Windows Server 2008: Click Start, choose Control Panel, and under Classic View, double-click 
Printers.

2 Windows 2000/XP: Double-click the Add Printer icon and click Next.
Windows Server 2003: Double-click the Add a printer icon and click Next.
Windows Vista/Server 2008: Click Add a printer.

3 Windows 2000/XP/Server 2003: Specify printing using a Local printer, clear the 
“Automatically detect and install my Plug and Play printer” option, and then click Next.
Windows Vista/Server 2008: Select Add a local printer.

4 Select Create a New Port, choose Standard TCP/IP Port from the Type of port menu, and then 
click Next.

5 Windows 2000/XP/Server 2003: Click Next in the Welcome to the Add Standard TCP/IP Printer 
Port Wizard dialog box.

The Add Standard TCP/IP Printer Port Wizard dialog box appears. Proceed to step 6.

Windows Vista/Server 2008: Select the Device Type, type the Hostname or IP address of the 
EX8002, and then click Next. Proceed to step 9.

6 Type the printer name or IP address of the EX8002 and click Next. 

Windows 2000/Server 2003: Proceed to step 7.

Windows XP: Select the Device Type and click Next.

7 Windows 2000/XP/Server 2003: Make sure that Generic Network Card is selected as Standard 
for Device Type and click Next.
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8 Windows 2000/XP/Server 2003: Click Finish to close the Add Standard TCP/IP Printer Port 
Wizard dialog box.

NOTE: If the device is not found on the network, the device is displayed instead of the Finish 
button. If a device is not found on the network, that could be for one of the following reasons:

• EX8002 is not powered on.

• Network is not connected.

• EX8002 is not configured properly.

• IP address is not correct. 

If you encounter one of the situations mentioned, you can continue to set up the port by 
configuring the port manually. See “To set up Standard TCP/IP Port (Raw or LPR) for 
Windows” on page 46 and follow steps 11 to 14 before proceeding step 9.

9 Click Have Disk in the dialog box displaying lists of manufacturers and printers.

The Install From Disk dialog box prompts you for the disk.

10 Insert the User Software DVD into the DVD drive, type the name of the DVD drive 
(for example, D:\), and then click Browse. Browse to the 
English\Prntdrvr\Ps_drvr\Win_2K_XP_VISTA folder. 

If you are installing from the files you downloaded from the EX8002 using the Downloads tab 
in WebTools, browse to prntdrvr\Prntdrvr\Ps_drvr\Win_2K_XP_VISTA and click Open.

11 Make sure that “oemsetup.inf” or “oemsetup” is selected and click Open.

The path is copied to the Install From Disk dialog box.

12 Verify that the path is correct and click OK.

13 In the Printers box, select the EX8002 printer driver as your printer and click Next.



PRINTING FROM WINDOWS 40

14 Type a name for the EX8002 in the Printer name field, indicate whether you want to make it 
the default printer, and then click Next.

This name is used in the Printers window and the queues window.

15 Follow the on-screen instructions.

Do not share the printer and do not print a Test Page at this time. Continue with the printer 
driver installation and at the last screen, click Finish.

The necessary files are installed on your hard disk. When installation is complete, the Printers 
window appears with an icon for the newly installed printer. 

Now you are ready to configure the installable options (see “Configuring installable options” 
on page 51).

If you want to set up a connection other than port 9100, proceed to “Setting up printing 
connections” on page 44.

To use the printer driver, you must select the following options in the Advanced tab of the 
printer driver after installation is complete:

• Spool print documents

• Start printing immediately

• Print spooled documents first
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Installing and connecting to a virtual printer

A virtual printer allows you to print to the EX8002 using a predefined set of job settings. You 
do not have to set print options manually. Before you can print to a virtual printer, the 
administrator must create and configure the virtual printer using Command WorkStation. 
After the virtual printer is set up, you can install the printer driver and printer description files 
on your computer from the EX8002 using Point and Print.

For more information about setting up virtual printers, see Utilities.

When you install the printer driver using Point and Print, you cannot configure installable 
options manually. Installable options are configured automatically. The installed options are 
displayed in the printer driver when you select the Two-Way Communication option.

TO SET UP A VIRTUAL PRINTER ON WINDOWS COMPUTERS USING POINT AND PRINT

1 Windows 2000/XP/Server 2003: Right-click Network Neighborhood or My Network Places, and 
select Find Computer or Search for Computers.
Windows Vista/Server 2008: Right-click Network and choose Open from the menu.

2 Windows 2000/XP/Server 2003: Type the name or IP address of the EX8002 and click Search 
Now or Search.
Windows Vista: Type the name of the EX8002 in the Search field and click Enter.
Windows Server 2008: Type the name or \\IP address of the EX8002 in the Search field and 
click Enter.

If you cannot locate the EX8002, contact your network administrator.

3 Double-click the EX8002 name to display enabled print connections.

Virtual printers are listed along with the Print queue, Hold queue, and Direct connection (if 
those connections are enabled). Virtual printers usually have names that indicate the type of 
job they are set up for.

4 Right-click the virtual printer that you want and choose Connect.

The files are installed on your computer.

5 Windows 2000: Click Start, choose Settings, and then choose Printers. 
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista: Click Start, choose Control Panel, and then double-click Printers.
Windows Server 2008: Click Start, choose Control Panel, and under Classic View, double-click 
Printers.

The virtual printer is displayed in the Printers or Printers and Faxes window.

You can print to a virtual printer as you would print to the EX8002. Depending on how the 
virtual printer is configured, you may not be able to set some print options.

You must enable Two-Way Communication to automatically update your printer driver to 
reflect the options currently installed on the digital press.
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TO ENABLE TWO-WAY COMMUNICATION

1 Windows 2000: Click Start, choose Settings, and then choose Printers. 
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista: Click Start, choose Control Panel, and then double-click Printers.
Windows Server 2008: Click Start, choose Control Panel, and under Classic View, double-click 
Printers.

2 Right-click the EX8002 icon and choose Properties.

3 Click the Installable Options tab.

4 Select Two-Way Communication.

5 Type the EX8002 IP address or DNS name. 

6 Select Update Fiery Driver When Opened to display the printer’s current default settings when 
the printer driver is opened. 

7 Click Update.

NOTE: To confirm that Two-Way Communication is enabled, click the About tab and check 
that the EX8002 name and other server information are displayed. 

8 Click OK.
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Uninstalling printer drivers

All installation of user software on a Windows computer is done through the Fiery User 
Software Installer. The procedures in Utilities describe installing from the User Software 
DVD.

The Printer Delete Utility is installed and used locally. You do not need to connect to the 
EX8002 before you use the software.

TO USE PRINTER DELETE UTILITY

1 Click Start, choose Programs, and then choose Fiery. 

2 Click FieryPrinterDeleteUtility.

The Fiery Driver Uninstall Tool dialog box appears. Any EX8002 printer drivers found on 
your computer are listed.

3 To delete a printer, select the check box next to the printer name and click Delete the 
Selected Printers.

To delete all the installed printer drivers, select the Delete All Printer Drivers check box.

4 Click OK to delete the selected printer driver(s).

5 When you finish deleting printer drivers, click Exit and restart your computer.
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Setting up the EX8002 for printing
To print from Windows computers, you or the administrator must perform the 
following tasks to set up a connection other than port 9100:

• Set up network servers, if any.

• Set up the EX8002 to accept print jobs from your computer.

• Configure a port on each Windows computer for the network type.

Setting up printing connections

The EX8002 supports the following printing connections:

• SMB

• Standard TCP/IP (RAW or LPR)

• IPP or IPP over SSL

For the location of each procedure, see the following table.

Procedure See

Completing the SMB printing connection page 45

Completing Standard TCP/IP Port (Raw or LPR) 
printing connections

page 45

Completing IPP connections page 49

Configuring installable options page 51
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Completing the SMB printing connection

If your network does not have a Windows server, Windows computers can still print to the 
EX8002. This method of printing is SMB printing (also known as Windows or WINS 
printing). When users send print jobs, computers running Windows operate in a peer-to-peer 
environment and communicate directly with the EX8002. 

Enabling SMB printing allows the EX8002 to be listed on the network, so that Windows 
clients can print to a particular print connection (Print queue, Hold queue, Direct connection 
or virtual printer) on the EX8002 without using other networking software. Windows 
printing runs via TCP/IP. You must configure TCP/IP on the EX8002 and on all computers 
that use SMB printing.

After you enable SMB printing on the EX8002, you can set up the Windows or SMB 
connection and install the printer driver in one procedure. For more information, see 
“Installing printer drivers by Point and Print” on page 33.

Completing Standard TCP/IP Port (Raw or LPR) printing connections

After you install the PostScript and printer driver files, you can add or configure the Setup 
for the Standard TCP/IP Port (Raw or LPR) connection as follows:

• Prepare the EX8002 to accept print jobs using Standard TCP/IP Port (Raw or LPR) 
protocols. 

• Enable LPD or Port 9100 on the EX8002. 

• Configure the computer for the TCP/IP connection.

For more information about Setup, see WebTools Configure Help.

Before you complete the following procedure, contact your system administrator for the 
IP address assigned to the EX8002.

The TCP/IP protocol should be installed as a default on the Windows computer. For Port 
9100, you can set up the connection and install the printer driver in one procedure.

NOTE: You can also set up the LPR Port connection by installing Print Services for UNIX, 
which is supplied as an add-on Windows component. For more information, see the 
documentation that accompanies Windows.
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TO SET UP STANDARD TCP/IP PORT (RAW OR LPR) FOR WINDOWS

NOTE: The following procedures use Windows XP illustrations.

1 Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista/Server 2008: Click Start, choose Control Panel, and then double-click Printers.

2 Right-click the EX8002 icon and choose Properties.

3 Click the Ports tab.

4 To add a new port, click Add Port.

To change the port settings, proceed to step 11. 

5 Windows 2000/XP/Server2003: Select Standard TCP/IP Port from the list of Available port 
types and click New Port Type.
Windows Vista/Server 2008: Double-click Standard TCP/IP Port from list. 

The Add Standard TCP/IP Printer Port Wizard dialog box appears.

6 Click Next. 
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7 Type the EX8002 IP address. 

8 Click Next.

9 Make sure that Generic Network Card is selected as Standard for Device Type and click Next.

10 Click Finish to close the Add Standard TCP/IP Printer Port Wizard dialog box, and then click 
Close in the Printer Ports dialog box.

To change the default setting, proceed to step 11. 

If you do not want to change the default setting, the setting is now completed.

NOTE: Port 9100 was set as the default setting in the preceding procedure.

11 Click Configure Port on the Ports tab of the Properties dialog box.

The Configure Standard TCP/IP Port Monitor dialog box appears.
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12 To use LPR printing, select LPR in the Protocol area and LPR Byte Counting Enabled in the LPR 
Settings area.

NOTE: You can also proceed without selecting LPR Byte Counting Enabled.

To use Port 9100 printing, select Raw in the Protocol area. 

The port number 9100 automatically appears in the Raw Settings area. This is the default 
port number. You can print to the printer connection selected for Port 9100 printing on the 
EX8002.

To specify a specific port number, see the following step.

13 Type the name of the print connection.

For LPR, enter print or hold for Queue Name or published virtual printer name. The Direct 
connection is not supported for LPR printing.

For Port 9100, type the following port numbers for each print connection in the Raw Settings 
area:

EX8002 default: 9100

direct: 9101

print: 9102

hold: 9103

NOTE: Type the number exactly as shown.

14 Click OK to close the Configure Standard TCP/IP Port Monitor dialog box.

NOTE: The EX8002 supports printing in the IPv6 environment on Windows Server 2008 and 
Windows Vista. 

NOTE: LPR printing in the IPv6 environment is supported on the Windows XP/Server 2003 
computer from a command line, but other methods may work.

15 Click Apply in the EX8002 Properties dialog box, and then click OK.
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Completing IPP connections

With Internet Printing Protocol (IPP), print jobs are sent to the EX8002 over the Internet.

Before you begin, perform the following tasks:

• Make sure that the EX8002 is configured for TCP/IP printing and IPP printing. 

For more information, see WebTools Configure Help.

• Specify the printing destination on your computer.

NOTE: IPP over SSL connections is supported.

TO SET UP IPP PRINTING WITH WINDOWS

1 Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista: Click Start, choose Control Panel, and then double-click Printers.
Windows Server 2008: Click Start, choose Control Panel, and under Classic View, double-click 
Printers.

2 Windows 2000/XP: Double-click the Add Printer icon and click Next.
Windows Server 2003: Double-click the Add a printer icon and click Next.
Windows Vista/Server 2008: Click Add a printer.

3 Windows 2000/XP/Server 2003: Select Network printer and click Next.
Windows Vista: Select Add a network printer.
Windows Server 2008: Select Add a network, wireless, or Bluetooth printer.

4 Windows 2000/XP/Server 2003/Vista: Select Connect to a printer on the Internet or on your 
intranet.
Windows Server 2008: If the printer search takes a long time, click Stop, and then click “The 
printer that I want isn’t listed.”
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5 Windows 2000/XP/Server 2003/Vista: In the URL field, type the IP address or DNS name of 
the EX8002, followed by “ipp/” and then the name of the connection (hold, direct, or print).

For example, http://10.10.10.150/ipp/print or http://DNS name of the EX8002/ipp/print 
sends the job to the Print queue on the EX8002. 

For IPP over SSL, type https, instead of http.

NOTE: The ipp/print in the example is case sensitive.

Windows Server 2008: Click Select a printer by name, and in the URL field, type the IP 
address or DNS name of the EX8002, followed by the name of the connection (hold, direct or 
print).

NOTE: For example, http://10.10.10.150/ipp/print or http://DNS name of EX8002/ipp
/print sends the job to the Print queue on the EX8002.
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NOTE: The URL for the printer is not case-sensitive. 

6 Windows 2000/XP/Server 2003/Vista: Click Next.

The Connect to Printer dialog box appears.

Windows Server 2008: Click Next.

7 Windows 2000/XP/Server 2003/Vista: Click OK.

The Add Printer Wizard dialog box appears. 

Windows Server 2008: Click Install driver.

8 If you are installing the PostScript printer for the first time, follow the procedure “To install 
and complete the print connection for Windows” on page 38, step 9.

9 Indicate whether you want to make the EX8002 the default printer and click Next.

10 Click Finish.

Configuring installable options

After you complete the printer driver installation, you must configure the EX8002 for the 
options installed on the digital press to allow the EX8002 to take advantage of the digital press 
options. Configure the options manually, or, for TCP/IP network connections, use the 
Two-Way Communication option to configure the options automatically. 

For information about specifying installable options, see printer driver Help.
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Printing from Windows computers
You can print to the EX8002 just as you would print to any other printer from a Windows 
application. You can print from a networked Windows computer or a computer using 
Windows (WINS) printing. 

The following table includes other methods to print to the EX8002 and the location in which 
to find more information.

After you install the EX8002 printer driver and configure the proper port, you can print 
directly from most Windows applications. Set the print options for the job and choose Print 
from your application.

To achieve optimal printing results from specific applications, see Color Printing, Fiery Color 
Reference, and Command WorkStation Help.

NOTE: The following procedures use Windows XP illustrations unless specified.

For the location of each procedure, see the following table.

For more information See

Downloading certain types of files to the EX8002 using 
the Docs WebTools

Utilities

Printing documents using Hot Folders Utilities

Printing documents using E-mail Services “E-mail Service” on page 62

Setting up the Windows environment for printing with 
Windows servers connected to the EX8002

Configuration and Setup

Procedure See

Setting print options and printing from Windows 
applications

page 53

Customizing the Basic icon page 58

Defining and printing custom page sizes page 59

Viewing the digital press status page 59

Saving files to print to a remote location page 59
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Setting print options and printing from Windows applications

To print from Windows platforms, install the PostScript printer driver. For instructions, see 
“Installing Windows printer drivers” on page 32. Be sure to configure the options on the 
Advanced tab of the printer driver after installation is complete, as described on page 38.

If you print to a virtual printer, you may not be able to set some print options, depending on 
how the virtual printer is configured.

The following procedures explain how to use the printer driver to specify print options for a 
particular job and print it to the EX8002. You can also set default print settings using the 
driver. For information about specific print options, see Print Options.

NOTE: The following procedures use Windows XP illustrations.

TO SET PRINT OPTIONS FOR A SPECIFIC WINDOWS PRINT JOB USING THE PRINTER DRIVER

1 Choose Print in your application.

2 Select the EX8002 as your printer and click Properties.

3 Click the Fiery Printing tab.

The Fiery Printing tab serves as the control center for all frequently used printing functions. 

For information about using presets, see printer driver Help.

NOTE: For a list of print options, see page 70.

1 Presets (Job Templates), 
see Help

2 Print Option icons
3 Customize (Shortcuts), 

see Help
4 Active area
5 Job View
6 Printer Status
7 Help

1

2

3

4

5

6

7
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4 Click the Job Info icon.

5 Type information in the Notes1 and 2 fields.

Type user and job identification information for managing purposes, or other information 
that is required at your site.

The information that you type in this field can be viewed and edited by the operator in 
Command WorkStation and also appears in the Job Log.

For more information about Command WorkStation, see Utilities.

6 Type instructions to the operator about the job in the Instructions field.

These instructions are displayed in Command WorkStation, but do not appear in the Job 
Log. These instructions can be edited by the operator.

7 Type a user name and password in the User Authentication area.

The user name that you type in the User Authentication area can be your network 
domain\user name or a local user name. Check with your system administrator about the 
requirements for your system.

If you do not have a user name and password or if you want to send jobs as a public user, 
select the I’m a Guest option. The EX8002 must be configured to allow guest printing. 
Otherwise, clear the I'm a Guest option.

If you are not using a network user name and password, you can type your domain\user name 
and password in the fields provided. Click Validate to validate the user name and password.

When the Use Windows Login option is selected, the LDAP domain user name and password 
are used as an authenticated user name. This is available only if the user is logged on to the 
Windows computer as a domain user.

Select the Save User Information option to save your user name and password.
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8 Type values for the other fields, as required.

For information about these fields, see page 70.

9 Click the Color icon and specify the color profile options for the job.

In the Print Mode area, select a color mode for the job. To use advanced color management 
features, such as Rendering Style, click Expert Settings and proceed to step 10. Otherwise, 
proceed to step 11.

10 In the Expert Color Settings dialog box, click Update to display the current EX8002 settings.

If the Update button does not appear, make sure that the Two-Way Communication option 
is selected, as described in “Viewing the digital press status” on page 59.

Two-Way Communication On
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11 Specify the color settings for the print job and click OK.

12 Click the Stamping icon to specify a watermark for the print job.

For more information about watermarks, see printer driver Help.

13 Click the Printer icon to view digital press status.

For more information about monitoring digital press status, see printer driver Help.

14 Click the remaining print option icons to specify the appropriate settings for the print job 
and click OK.

The settings that you make for these print options override settings that the administrator 
specified in EX8002 Printer Setup, but can be overridden from Command WorkStation. For 
information about these options and overrides, see page 69. For more information about 
Command WorkStation, see Utilities.

Some print options are available only if a particular installable option has been configured. 
For information about configuring installable options, see “Configuring installable options” 
on page 51.

If you choose Printer’s default, the job prints according to the settings that the administrator 
specified in Setup. For more information, see page 69.

NOTE: If you specify incompatible print settings, the Conflict dialog box provides instructions 
to resolve the conflict.

15 From your application, click OK to send your print job.

Make sure that the EX8002 is selected as your current printer.

NOTE: Some print options that are selectable from an application are similar to print options 
that are specific to the EX8002 and the digital press. In these cases, use the print options 
specific to the EX8002 and the digital press. These options appear in the Fiery Printing tab. 
The application may not set up the file properly for printing on the EX8002, resulting in 
unexpected finishing, printing errors, or longer processing time.

NOTE: With the E-mail Notification feature enabled in the printer driver, you receive an 
e-mail notification after your job is printed or when a printing error occurs.

For more information about the E-mail Notification feature, see printer driver Help.
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TO SET DEFAULT PRINT OPTIONS FOR WINDOWS PRINT JOBS USING THE POSTSCRIPT PRINTER DRIVER

1 Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista/Server 2008: Click Start, choose Control Panel, and then double-click Printers.

2 Right-click the EX8002 icon and choose Printing Preferences.

3 If the Fiery Printing tab is not displayed, click it.

4 Specify the default settings for your print job, as described on page 53.

5 Click OK to close the dialog box.
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Customizing the Basic icon

The Basic icon is on the Fiery Printing tab. You can customize it with the print options you 
use frequently. This saves time because you do not have to open all of the other print option 
icons if you only want to set the options in Basic. Basic initially contains a default group of 
print options. You can remove these options and add others.

NOTE: When you place a print option in Basic, it still appears under its appropriate print 
option icon. You can set the option from either location.

For more information about customizing the Basic icon, see printer driver Help.

1 Basic icon
2 Customize (Shortcuts)

1

2
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Defining and printing custom page sizes

With custom page sizes, you define the dimensions of a printed page. After you define a 
custom page size, you can use it from within an application without redefining it each time 
you print. When you create custom page sizes, specify Width dimensions to correspond with 
the shorter side of your job and specify Height dimensions to correspond with the longer side 
of your job. Set custom page sizes in this way, regardless of the orientation settings in the 
application.

NOTE: Custom page sizes are not supported with Imposition jobs.

For more information about defining and printing custom page sizes, see printer driver Help.

Viewing the digital press status

If you enabled a TCP/IP network, you can retrieve digital press status and color settings from 
the EX8002 and display them in the printer driver using the Two-Way Communication 
feature. If you have enabled Two-Way Communication for your digital press, you can 
monitor the status of the digital press, including the levels of consumable materials, such as 
paper and toner.

For more information enabling Two-Way Communication, see printer driver Help.

Saving files to print at a remote location

If you do not have an EX8002 onsite and are preparing files to take to a service bureau 
or other location, print the final files to the File port (as opposed to one of the local ports). 
You can also print to the File port to create a file to download using the Docs WebTool. For 
instructions on printing to the File port, see the documentation that accompanies Windows.

Height

Width

Width

Height

Portrait Landscape
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PRINTING METHODS

In addition to printing jobs from the EX8002 printer driver, you can print jobs using the 
following utilities:

• Job Monitor displays information about the jobs sent to the EX8002 and reprints them.

• E-mail Service submits jobs to the EX8002 as e-mail attachments.

• USB device prints files saved on a USB drive.

• FTP printing prints to the EX8002 using the FTP protocol.

For the location of each procedure, see the following table.

Procedure See

Configuring and using Job Monitor page 61

E-mail Service page 62

Printing from USB device page 66

FTP printing page 67
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Configuring and using Job Monitor
Use Job Monitor to monitor the status of EX8002 and view information about the print jobs 
sent to them.

NOTE: Job Monitor is not supported on Windows 2008, Windows XP/Server 2003/Vista 
64-bit version or Mac OS X.

Configuring the connection

When you send your first print job to the EX8002, Job Monitor opens and establishes a 
connection to the EX8002. If you have installed and configured printer drivers for more than 
one digital press, Job Monitor automatically establishes connections to all the EX8002 digital 
presses.

The Job Monitor icon ( ) appears on the desktop and in the Windows taskbar of 
your computer.

Job Monitor is automatically installed when you choose the printer driver to install on your 
computer. To use Job Monitor, you must enable it in the printer driver.

TO ENABLE JOB MONITOR

• Select the Monitor my Print Job check box on the Printer tab of the printer driver.

TO DISABLE JOB MONITOR

• Clear the Monitor my Print Job check box on the Printer tab of the printer driver.

Using Job Monitor

For information about using Job Monitor, see Job Monitor Help and printer driver Help. 
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E-mail Service
E-mail Service allows you to control the EX8002 using your current e-mail infrastructure, 
print to remote locations, and bypass firewalls. E-mail Service is not application-specific. 
You can use any e-mail infrastructure.

NOTE: E-mail Service is not supported on Mac OS X.

The EX8002 supports internal address books. Administrators can retrieve, add, delete, and 
clear addresses from the address books by sending requests through e-mail. For more 
information about address books, see Configuration and Setup.

To set up E-mail Service, see WebTools Configure Help.

Use E-mail Service in the following ways:

• Print a job from an e-mail application.

To print with an e-mail client, you send a file as an e-mail attachment. E-mail Service 
extracts the file and sends it to the EX8002. The attachment can be in any format the 
EX8002 recognizes (PostScript, PDF, or TIFF).

NOTE: E-mail Service does not process files with .vbs, .exe, or .bat extensions.

• Manage jobs using an e-mail application.

You can manage your print jobs by submitting e-mail commands to the EX8002 using 
e-mail.

• Scan to E-mail

You can scan a document and send it to an e-mail address as an attachment or URL. 
For more information about Scan to E-mail, see Utilities.
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Printing using an e-mail client

You can submit print jobs to the EX8002 in the form of an e-mail attachment using your 
e-mail application. When you send an e-mail with an attachment, E-mail Service extracts the 
file and sends it to the EX8002 Print queue. The file format must be one supported by the 
EX8002. 

By default, anyone can print with an e-mail client, unless the Print address book has been set 
up by the administrator. If the Print address book has been set up and your e-mail address is 
not in it, you cannot send files to the EX8002 via e-mail. For more information about address 
books, see Configuration and Setup. 

When User Authentication is enabled on the EX8002, the e-mail attachment must have the 
appropriate user name and password when it is printed through e-mail printing. As part of 
creating the e-mail attachment with the EX8002 printer driver, type the appropriate user 
name and password in the Job Info tab of the printer driver. The user name and password 
must match those defined by the administrator in the Users and Groups section of Configure. 
For information about Users and Groups, see WebTools Configure Help.

NOTE: The Direct connection is not supported by the e-mail client feature.

NOTE: The following illustrations depict the Microsoft Outlook e-mail application. 

TO PRINT USING AN E-MAIL CLIENT

1 Open your e-mail application.

2 Type the EX8002 e-mail address in the To: line.

3 Type text in the Subject line or leave the Subject line blank.
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4 Attach the file that you want to print. 

The attachment can be in any format the EX8002 recognizes (PostScript, PDF, or TIFF).

NOTE: If your attachment exceeds the file size limitation set by your e-mail system 
administrator, the e-mail is not sent. 

5 Optionally, you can type text in the body of the message. The text is printed with the file.

NOTE: HTML-formatted e-mail messages are not supported, and might not print as they 
appear on the remote workstation. Send e-mail messages in plain text format.

6 Send the e-mail.

The file is sent to the EX8002 and the job is printed. After the EX8002 receives the job, you 
receive an e-mail notification that the print job was accepted. The e-mail provides a job 
identification (ID). Use the job IDs to manage jobs with e-mail commands (see “Managing 
print jobs with e-mail commands” on page 65). The e-mail notification indicates any current 
error at the digital press. 

After the job has been printed, you are sent a second e-mail notification that indicates the job 
printed successfully. 
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Managing print jobs with e-mail commands

You can manage your print jobs by submitting commands to the EX8002 using e-mail. You 
can cancel a job, check job status, and get help on a job. When you send a command, the 
EX8002 returns an e-mail response. 

TO MANAGE PRINT JOBS WITH E-MAIL COMMANDS

1 In your e-mail application, type the EX8002 e-mail address in the To: line.

2 Type one of the following commands in the Subject line:

To check the status of a job, type #JobStatus<job id> in the Subject line.

You receive a reply to your job status query. You can only get the status of the job if you sent 
the job or are an administrator.

To cancel a job, type #CancelJob<job id> in the Subject line. 

You receive a notification indicating that the job has been cancelled and did not print to the 
EX8002. You can only cancel a job if you sent the job or are an administrator.

To get help, type #Help in the Subject line.

You receive an e-mail response that contains links that allow you to cancel jobs, check job 
status, and search and manage address books. Click any of the links to perform a command.

3 Send the e-mail to the EX8002.
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Printing from a USB device
You can print files on a USB device to the EX8002. To do so, save files to the USB device and 
download them directly to the EX8002. You can print files that originated on Mac OS X or 
Windows computers.

You can print files automatically from a USB device to one of the standard print queues on 
the EX8002 (Print, Hold, or Direct) or to published virtual printers (if supported). Verify 
with your administrator that these connections are published in Setup. For more information 
about virtual printers, see Utilities.

Before you print files from a USB device, ask your administrator to configure the appropriate 
options. For more information about configuring the appropriate options, see Configuration 
and Setup or WebTools Configure Help.

Automatic printing

To print automatically to Print, Hold, or Direct queues, or to published virtual printers with 
the Print All setting, set up folders on your USB device with the names print, hold, direct, and 
the names of any published virtual printers. When you plug the USB device into a USB port 
on the EX8002, the files in those folders are sent automatically to the corresponding queues. 

TO PRINT FILES FROM THE USB DEVICE

1 Configure the USB printing options in Setup.

2 Create folders at the top (root) level of the USB device named print, hold, direct, and virtual 
printer.

3 Save the files (PS, EPS, TIFF, and PDF) from the user’s computer to the USB device. 

Files copied to the print, hold, direct, or virtual printer folders are downloaded to the 
corresponding print connection on the EX8002 automatically when you connect the USB 
device to the EX8002. Files copied to the root level of the USB device are downloaded to the 
Print queue.

4 Remove the USB device from the computer and connect it to the USB connector on the 
EX8002. 

Make sure that the USB device is properly stopped before you disconnect it from the 
computer.

For the location of the USB port, see Configuration and Setup. 
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FTP printing
If FTP Services are enabled on the EX8002, the EX8002 is set up as an FTP server. You can 
send jobs to the EX8002 using FTP printing. For more information about configuring FTP 
Services, see Configuration and Setup.

You can use any FTP client software. Before you use FTP printing, the FTP client software 
requires the following information (see your administrator):

• IP address or DNS name for the EX8002

• Directory or path to send the job to, such as the Print queue, Hold queue, or published 
virtual printers (if supported)

NOTE: You cannot print to the Direct connection using FTP printing.

• User name and password (if required)

You can send PostScript (PS), Tagged Image File Format (TIFF), and Portable Document 
Format (PDF) files to the EX8002. Encapsulated PostScript (EPS) files are not supported for 
FTP printing.

TO PRINT FILES TO THE EX8002 USING THE FTP PROTOCOL

1 Connect to the EX8002 with your FTP client software.

Folders corresponding to the Print queue and Hold queue are displayed. Folders for any 
published virtual printer are also displayed.

2 Navigate to the folder representing the print connection or published virtual printer.

3 Upload your job to the folder that you want.

After the job is printed, it is deleted from the EX8002.
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PRINT OPTIONS

This chapter describes printer drivers and PPD (PostScript Printer Description) files, EX8002 
print options, and where to set print options.

About printer drivers and printer description files
The EX8002 receives files from computers on the network, processes (RIPs) the files, and 
then sends them to the digital press. Windows and Mac OS computers communicate with the 
EX8002 by means of a printer driver and PPD files. The driver allows you to use special 
features of the EX8002 from the Print dialog box. 

A printer driver manages printing communication between your application and the printer. 
It interprets the instructions generated by the application, merges those instructions with 
printer-specific options you set, and then translates all information into Adobe PostScript, 
a language the printer understands. In other words, the printer driver writes a PostScript file 
based on your original file and the options you set from the Print dialog box.

A printer driver also allows you to select print options for your digital press. To do this, the 
printer driver must be matched with a PostScript Printer Description (PPD) file for your 
EX8002. A PPD file contains information about the features and capabilities of a particular 
device (for example, what paper sizes and media types are supported). The printer driver reads 
the information in the PPD file and presents the information to you in the form of options 
you select in the Print dialog box. The PPD file for the EX8002 includes information about 
the features of both the digital press and the EX8002. For information about the specific print 
options for the EX8002, see the tables that begin on page 71.
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Setting print options
Print options give you access to the special features of your digital press and the EX8002. You 
can specify print options in these areas:

• Setup

Some settings are specified during Setup by the administrator. For information about the 
current default server settings, contact the administrator or the operator.

• Applications

With the printer drivers provided, you can specify job settings when you print a job.

For more information, see “Setting print options and printing from Windows 
applications” on page 53 and “Setting print options and printing from Mac OS X 
applications” on page 24. 

• Color Setup

Set the default CMYK Simulation Profile, CMYK Simulation Method, RGB Source 
Profile, RGB Separation, Output Profile, Rendering Style, Spot Color Matching, Print 
Gray using Black Only, Black Text/Graphics, and Black Overprint settings. 

For information about using Color Setup, see Color Printing.

• Hot Folders

Assign a group of print options to a Hot Folder. When you specify print options for a 
Hot Folder, the print options are assigned to all jobs sent through that Hot Folder. 
These print options override any default options. 

For information, see Hot Folders Help.

• Overrides in Command WorkStation

To change job settings from Command WorkStation, double-click a job to display the 
Properties dialog box. 

For  information, see Command WorkStation Help.

Print option override hierarchy

The override hierarchy is as follows: 

• A user’s printer driver settings override the EX8002 Setup settings.

• Settings assigned to Hot Folders override the user’s printer driver settings.

• Settings made from the job management tools (Command WorkStation Job Properties) 
override the user’s printer driver settings.
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Print options and default settings
If you do not use the printer driver interface to configure a particular option, the EX8002 
prints the job with the default setting. For options that you configure in Setup from the 
digital press control panel, Command WorkStation, or the Configure WebTool, choosing 
Printer’s default results in the EX8002 printing the job with the factory default. For options 
that cannot be configured in Setup, the EX8002 prints the job with a preconfigured Printer’s 
default setting. When you select the printer driver for US, the default Document Size is Letter 
or for International, the default Document Size is A4. For more information, see the 
following tables.

To determine the current Setup defaults, print the Configuration page from Command 
WorkStation or the digital press control panel. For information about how to print a 
Configuration page, see Configuration and Setup.

The print option tables are organized according to the printer driver icons (tabs). Use the 
following links for quick access:

Printer driver icon See

Basic or Quick Access (shortcuts) page 24 or page 58

Job Info page 71

Media page 73

Layout page 75

Color page 80

Image page 84

Finishing page 85

Variable Data Printing (VDP) page 86

Stamping/Watermark page 87
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Job Info options

Option Information

Copies The maximum number of copies is 9999.

Print Range Specify the page range or odd/even pages to print.

For VDP jobs, a range of Records can be selected for printing. For imposed VDP jobs, a range of 
Records & Sheets can be printed.

For imposed jobs, a range of Sheet IDs can be selected for printing.

This option is only accessible from Command WorkStation.

Schedule Printing Specify if you want to perform advance print scheduling based on date and time. If you select 
On, select the date and time for the print job.

The job is printed based on the date and time set on the EX8002, not the client workstation.

If multiple jobs are selected and defined with the same date and time setting, job order is based on 
alphabetic order of the file names.

User Authentication: 
Username 

If User Authentication is enabled on the EX8002, specify your User Name to print a job. Type your 
user name or domain\user name for user authentication.

User Authentication: 
Password 

If User Authentication is enabled on the EX8002, specify your User Password to print a job. Type your 
local password or domain password for user authentication.

User Authentication: 
Use Windows Login 

If you are logged on to your Windows computer, select Use Windows Login for user authentication.

This option appears when you log on to your domain on your Windows computer. 

For more information, see Configuration and Setup.

User Authentication: 
Save User Information 

Select On to save the user name and password information or the guest option for user authentication 
in subsequent sessions.

User Authentication: 
I’m a Guest

Select On to allow guest printing. Guest printing must be set to On at the EX8002.

In Command WorkStation, the management of jobs is determined by how you log on to the EX8002.

Notes 1/Notes 2 Specify information about the job. This field has a 31-character (alphanumeric and special characters) 
limit.

Instructions Specify instructions for the operator about the job. This field has a 127-character (alphanumeric and 
special characters) limit. 

Print Queue Action Select the job action associated with a published queue.

Select Print to send the file directly to printing.

Select Print and Hold to save the raster file after printing.

Select Process and Hold to RIP (process), but not print a job.

This option is invalid if your job is sent to the Direct connection.
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Control Bar Specify On to print a Control Bar (for print job identification) in the margin.

This option is available as part of the Fiery Graphic Arts Package, Premium Edition. For more 
information, see Fiery Graphic Arts Package. 

Printer’s default reflects the setting specified in ColorWise Pro Tools setup.

Progressives Specify On to enable the Progressives feature, a diagnostic tool used to show toner separations.

This feature uses the Progressives values specified in ColorWise Pro Tools Setup.

This option is available as part of the Fiery Graphic Arts Package, Premium Edition. For more 
information, see Fiery Graphic Arts Package.

NOTE: The Progressives and Postflight features cannot be used at the same time,

Postflight Specify whether or not you want to use the Postflight feature, a diagnostic tool that allows you to 
analyze how data is processed by the EX8002.

This option is available as part of the Fiery Graphic Arts Package, Premium Edition. For more 
information, see Fiery Graphic Arts Package.

NOTE: The Progressives and Postflight features cannot be used at the same time,

Option Information
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Media options

Option Information

Paper Catalog Click Select Media to access the Paper Catalog utility, which retrieves all paper information from the 
digital press.

For information about using Paper Catalog, see Utilities and Paper Catalog Help.

Access to Paper Catalog requires Two-Way Communication. For information about establishing 
Two-Way Communication, see printer driver Help.

Document Size Document Size is the page size defined in your application’s Print setup (or Page setup) dialog box. 

In cases when printing one document page per sheet of paper, Document Size is usually the same as 
Paper Size. However, it may differ when printing booklets or imposing multiple document pages on a 
single sheet. 

Document Size may also differ from Paper Size when you use the Scale or Scale to Fit options, in 
which case the document page size is scaled at a given percent to fit a certain paper size.

Select from the list of available sizes in the Document size menu. (SEF stands for Short Edge Feed; 
LEF stands for Long Edge Feed.)

NOTE: The default is Letter in the US and A4 elsewhere.

For more information about Document size and Paper size, see page 92.

For information about Scale and Scale to fit, see page 99.

For information about printing custom page sizes, see page 31 and page 59.

Paper Size Paper Size defines the size of the sheet of paper on which your job prints. It is the size of the physical 
sheet of paper in the digital press tray. To assign Paper Size, do one of the following:

• Select the size from the available list.

• Select Define custom size to select a non-standard paper size.

• Select Same as Page Size to print one document page per sheet of paper.

The default size is Letter in the US and A4 elsewhere. For more information, see page 92.

Paper Source Specify the paper source that contains the paper to use for the print job. For more information, see 
page 98.

For information about setting your choice of media in the Bypass, see the documentation that 
accompanies your digital press.
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Media Type Choose the media type for your print job. 

Media types that appear in gray indicate that Face-Down Printing must be set to Off. (A Conflict pane 
alerts you and automatically changes this setting.)

For information about media types and paper specifications, see the documentation that accompanies 
the digital press.

Tray Alignment Specify Enable to adjust the image on the page to achieve alignment on both sides of a page when 
printing duplex. For more information about tray alignment, see Utilities.

Mixed Media Click Define to specify different media types, paper source, and chapter-based finishing for pages, or 
ranges of pages, within a print job. 

For more information, see page 96. For information about using Mixed Media in Command 
WorkStation, see Utilities.

Option Information
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Layout options

The Driver has three layout modes:

• Normal - use these options for printing standard documents, from 1 to 16 document 
pages per sheet (page 75)

• Booklet - use these options for printing documents in booklet layout (page 76)

• Gang-up print - use these options for speed printing imposition modes (page 79)

Normal

Option Information

Scale Specify an increase or decrease in the scale of your print job. When using the manual Scale option, you 
cannot specify Scale to Fit.

For more information, see page 99.

Scale to Fit Specify whether to scale your job to fit to a paper size. When using the Scale to Fit option, you cannot 
use the manual Scale option.

For more information, see page 99.

Orientation Specify the orientation of the document.

This option is not available from the Mac OS X printer driver.

Rotate 180 (check box) Specify On to rotate the pages of a landscape job 180 degrees.

This option is not available from the Mac OS X printer driver.

Mirror Print the mirror image of your job, with text and image reversed (as if viewed in a mirror).

This option is not available from the Mac OS X printer driver.

Pages per sheet Specify the number of document pages per sheet of paper for your print job.

NOTE: This option is invalid if your job is sent to the Direct connection.

Print Border Select On to print borders around each page in your print job.

Page Order Specify the layout direction when the Pages per sheet option is set to 2-up or greater.

Duplex Specify Off for simplex (single-sided) printing.

Specify Head to Head or Head to Toe for duplex (double-sided) printing by specifying the orientation 
of printed pages.

For more information, see page 93.

Booklet Specify how to arrange the pages of the job in special layouts for folding or cutting after printing.

For a list of options and available settings, see the table on page 76. For additional information, see 
page 89.

Gang-up For a list of options and available settings, see the table on page 79. For additional information, see 
page 94.
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Booklet options

Option Information

Booklet type: Booklet Type Booklet Type is a combination of binding method, which determines how the signatures of the 
booklet are folded and imposed, and binding edge, which determines the location of the spine of the 
booklet.

For more information, see Booklet Maker Help.

Booklet type: Cover The initial Cover option (Saddle only) prepares a cover for your booklet. 

In Basic mode, you will define Cover options and media in final steps.

If you select Cover is prepared for the booklet, you will define the Cover content, Cover media, and 
Booklet Cover Source in the final steps of the booklet process.

If you select Cover is not prepared, Booklet Maker skips the remaining Cover options.

For more information, see Booklet Maker Help.

Paper size: Paper Size for 2-up Paper Size for 2-up defines the size of the sheet of paper (unfolded) on which your booklet will print. 

To select a Paper size for your booklet, do one of the following:

• Select from the list of available sizes in the Paper Size for 2-up menu.

• Select from Paper Catalog to access a dynamic database that stores the media attributes of any 
paper available for printing from the EX8002.

• Select Define custom size to create a non-standard Paper size.

The default Paper Size is Letter in the US and A4 elsewhere.

For more information, see page 92 and Booklet Maker Help.

For information about Paper Catalog, see Utilities.

For information about printing custom page sizes, see page 31 and page 59.

Paper size: Document size Document size is the page size defined in your application’s Print setup (or Page setup) dialog box. 

Select from the list of available sizes in the Document size menu.

To override Document size, select from the list of available sizes or choose Define custom size.

The default Document size is Letter in the US and A4 elsewhere.

For information about Paper size and Document size in booklets, see Booklet Maker Help.

When you access Booklet Maker from Command WorkStation Job Properties, Document size is not 
an option.

Number of sheets in a subset 
(saddle)

When Nested Saddle is selected, use this option to specify the number of sheets in each subset.

This option appears only when Nested Saddle is selected.
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Paper size: Shrink to fit Shrink to fit automatically scales down the document page to fit the paper size specified from the Paper 
size menu.

When Shrink to fit is set to Off, page content prints at 100%.

Shrink to fit only reduces or scales down the document page size. Shrink to fit does not scale up or 
enlarge.

For information about Shrink to fit, see Booklet Maker Help.

The Shrink to fit option is available only in Advanced mode.

Page alignment: Align pages
Align pages (Win)
Centering Adjustment 
(Mac & CWS)

Align pages positions page content in relation to the center of one-half the paper size or the spine, the 
center of the sheet where the fold occurs.

At the center positions page content in the center of one-half the specified paper size.

At the spine aligns page content with the spine or center fold of your booklet.

For information about page alignment, see Booklet Maker Help.

Page alignment: 
Increase gutter by
0/-50–50 mm 
(0.1 mm increments)
0/-1.97–1.97 in 
(.005 inch increments)

Increase gutter by controls the amount of space between adjacent pages to adjust for binding or other 
finishing options. 

Specify a positive value to increase the amount of blank space between adjacent pages.

Specify a negative value to decrease the amount of blank space between adjacent pages.

For information about gutters in booklet printing, see Booklet Maker Help.

Page alignment: 
Compensate creep for

Compensate creep for adjusts the position of the page content to counteract the shift that occurs when 
sheets are folded to create Saddle and Nested Saddle booklets.

Select Plain when printing Saddle or Nested Saddle booklets with a large number of pages.

Select Thick when printing Saddle or Nested Saddle booklets on heavyweight paper.

For information about creep compensation, see Booklet Maker Help.

Cover Content: Content input Select None (use insert) to insert a pre-printed cover that will be added to the body pages from an 
inserter tray.

Select As Separate Pages to include cover content (individual pages in your document) as part of your 
booklet print job.

For information about Cover options, see Booklet Maker Help.

Option Information
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Cover Content: Front Cover When As Separate Pages is selected, use the Front Cover option to define how the content of the front 
cover is printed.

Select Print on outside to print only on the outside of the front cover (the inside of the front cover will 
be blank).

Select Print on inside to print only on the inside of the front cover (the outside of the front cover will 
be blank).

Select Print on both sides to print on both the inside and outside of the front cover.

Select Do not print if you do not want any content printed on the front cover.

When you add a cover, blank pages may be inserted depending on the allocation of pages to signatures. 

For information about cover options, see Booklet Maker Help.

Cover Content: Back Cover When As Separate Pages is selected, use the Back Cover option to define how the content of the back 
cover is printed.

Select Print on outside to print only on the outside of the back cover (the inside of the back cover will 
be blank).

Select Print on inside to print only on the inside of the back cover (the outside of the back cover will be 
blank).

Select Print on both sides to print on both the inside and outside of the back cover.

Select Do not print if you do not want any content printed on the back cover.

When you add a cover, blank pages may be inserted depending on the allocation of pages to signatures 
in the job. 

For information about cover options, see Booklet Maker Help.

Cover Media: Cover Media Cover Media (Saddle only) specifies the media for your booklet print job.

Choose Same as body to use the same media as the body pages of your job.

Choose Select from Paper Catalog to access the Paper Catalog utility. which retrieves all paper 
information form the digital press.

NOTE: Cover Media is not an option for Mac OS.

For information about using Paper Catalog, see Utilities and Paper Catalog Help.

Cover Media: Booklet Cover 
Source

Booklet Cover Source (Saddle only) selects the tray that contains the Cover media for your booklet. 

Option Information



PRINT OPTIONS 79

Gang-up print

Option Information

Gang-up type Select Step & repeat to speed print a job by printing two document pages on each sheet. When the 
printed sheets are cut in half, the result is two complete sets of the same document.

Select Cut & stack to speed print a job by printing two document pages side by side. When the printed 
sheets are cut in half and stacked together, the result is one complete set of the document (in faster 
printing time).

For more information, see page 94.

Paper size Select from the list of available sizes in the Paper size menu.

Select Define custom size to select a non-standard Paper size.

Select from Paper Catalog to access a dynamic database that stores the media attributes of any paper 
available for printing from the EX8002.

For information about Paper size and Document size, see page 92. 

For information about printing custom page sizes, see page 31 and page 59. 

For information about Paper Catalog, see Utilities.

Document size Document size is the page size defined in your original application’s Print setup (or Page setup) dialog 
box.

To override specified Document size, select from the list of available sizes or choose Define Custom 
size.

The default Document size is Letter in the US, and A4 elsewhere.

For more information, see page 92.

Orientation Orientation displays the aspect ratio (portrait or landscape) defined in your original application’s Print 
setup (or Page setup) dialog box. Use this option to override if necessary.

Shrink to fit Shrink to fit scales down document pages to fit the paper size you select, and only reduces or scales 
down the document page size. It does not scale up or enlarge.

When Shrink to fit is set to Off, page contents print at 100%.

Increase gutter by 
0/-50–50 mm 
(0.1 mm increments)
0/-1.97–1.97 in 
(.005 inch increments)

Increase gutter by controls the amount of space between adjacent pages on a sheet to adjust for 
trimming or other finishing options. 

Specify a positive value to increase the amount of blank space between adjacent pages.

Specify a negative value to decrease the amount of blank space between adjacent pages.

Duplex Select Off for single-sided printing.

Specify Head to Head for duplex (double-sided) printing with both sides using the same top edge.

Specify Head to Toe for duplex printing with the back side upside down.

For more information, see page 93.
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Color options
.

Option Information

Color Mode (Mac and CWS)
Print Mode (Win)

Specify the color mode for the current print job.

Select CMYK for a full-color document.

Select Grayscale for a grayscale or black-and-white document.

Choose Expert Settings to set other color print options and settings, including Black Overprint, Black 
Text/Graphics, and Print Gray using Black Only. 

For information about Expert Settings, see page 81.

Auto Trapping Specify whether the job should automatically reduce white gaps for text and graphics.

For more information, see page 89.

Setting this option to On may result in graphics or text surrounded with borders.

Combine Separations When printing separations from supported desktop publishing applications:

Select On to combine separations on a single page. 

Select Off to view separations as four individual black-and-white pages, each representing one color 
plate.

For more information, see Color Printing.

Composite Overprint Select On to overprint objects that are specified in the source PostScript or PDF file.

Design applications are typically set to knock out objects. To overprint, you must first change the 
settings in the source application. When the Composite Overprint option is then set to On, the 
overprinting commands specified in the source application take place, provided the output is 
composite and consistent with the separations output.

For more information, see Color Printing.

Substitute Colors Select On to use the Substitute Color Values defined in the Spot-On module. 

For more information, see Color Printing.

2-Color Print Mapping Specify if you want to replace spot colors with generic colors when you are creating a print job. 

This option is available as part of the Fiery Graphic Arts Package, Premium Edition. 

For more information, see Fiery Graphic Arts Package.
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Expert Settings options

To access the following options, click Expert Settings.
.

Option Information

Black Overprint Select Text to overprint black text. Select Text/Graphics to overprint black text and graphics. 

For more information, see Color Printing.

Black Text/Graphics Select Normal to print black text and graphics as a four-color black using C, M, Y, and K toner, and to 
use normal PostScript rendering.

Select Pure Black On to print black text and graphics as a one-color black, using black toner only.

Select Rich Black On to print black text and graphics as richer looking black, by layering a small 
amount of Cyan toner underneath the black toner to make the black even darker.

This option is automatically set to On if the Black Overprint option is enabled.

For more information, see Color Printing.

CMYK Simulation Method Specify the simulation method for CMYK print jobs. 

Select Full (Source GCR) for a more complete and accurate simulation. Full (Source GCR) applies 
colorimetric transformations that adjust hue as well as output density and produces output that 
maintains the same amount of black as the source document. 

Select Full (Output GCR) to apply the same simulation method as Full (Source GCR), except that the 
output produced contains a black amount determined by the Output Profile.

Select Quick to use one-dimensional transfer curves to adjust density output of individual color 
channels.

For more information, see Color Printing.

CMYK Simulation Profile Specify the simulation goal to be used for the current print job.

If Two-Way Communication is enabled, Simulation 1–Simulation 10 do not appear in the list of 
profiles and the profile names differ slightly.

For more information, see Color Printing.

Output Profile Specify the output profile to use for the current print job. 

For information about output profiles, see Color Printing.

Paper Simulation Specify to adjust the color according to the shade of the paper stock used as printable CMYK values in 
the output color space. 

This option is available as part of the Fiery Graphic Arts Package, Premium Edition. For more 
information, see Fiery Graphic Arts Package. 
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Print Gray using Black Only 
(CMYK)

Select these settings to print a CMYK job using black toner instead of process black.

This option renders the selected object types (Text/Graphics or Text/Graphics/Images) in grayscale 
using black only, when C=M=Y=0 and K=n, where n is not zero. Graphics refer to vector graphics and 
Images refer to raster images.

This option is designed to use black efficiently, by using only black toner (rather than four-color 
process black).

For more information, see Color Printing.

Print Gray using Black Only 
(RGB)

Select these settings to print an RGB job using black toner instead of process black.

This option renders the selected object types (Text/Graphics or Text/Graphics/Images) in grayscale 
using black only, when R=G=B. Graphics refer to vector graphics and Images refer to raster images.

This option is designed to use black efficiently, by using only black toner (rather than four-color 
process black).

For more information, see Color Printing.

Rendering Style Specify a default CRD (color rendering dictionary) for color conversion when printing RGB images, 
objects, and text.

Select Presentation to print files with artwork, graphics and text. The result is similar to Photographic, 
with well-rendered flesh tones and more saturated colors.

Select Photographic to print photographs, including scanned and digital camera images. The result is 
less saturated than Presentation style.

Select Relative Colorimetric when color matching is important, but you also want to print white as 
paper white. The white point transformation eliminates borders between blank spaces and white 
objects.

Select Absolute Colorimetric when exact colors are required and visible borders are not distracting. 
There is no white point transformation.

For more information, see Color Printing.

RGB Separation Select Simulation for RGB jobs for which you want to simulate an output device other than the device 
to which you are printing.

Select Output for RGB jobs that you are printing to the final output device.

If Two-Way Communication is not enabled, this option is set to Printer’s default, which reflects the 
setting specified in Color Setup. For more information, see Color Printing.

RGB Source Profile Specify a source color space definition for printing RGB images, objects, and text.

If Two-Way Communication is enabled, Source 1–Source 10 do not appear in the list of profiles and 
the profile names differ slightly.

For more information, see Color Printing.

Option Information
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Spot Color Matching Select Off to print specified PANTONE colors in your job using the current CMYK Simulation and 
CMYK Simulation Method.

Select On to activate the PANTONE Lookup Table. The EX8002 prints specified PANTONE colors 
in your job by matching the CMYK print blend to the same color from the PANTONE library.

If Two-Way Communication is not enabled, this option is set to Printer’s default, which reflects the 
setting specified in ColorWise Pro Tools. For more information, see Color Printing.

Use PDF/X Output Intent Specify On to enable the PDF/X Output Intent feature to use the embedded output intent for PDF/X 
compliant print jobs.

To use PDF/X Output Intent, you must set the RGB Source Profile to None.

For information about the PDF/X Output Intent feature, see Color Printing.

This option is only accessible from Command WorkStation.

Option Information



PRINT OPTIONS 84

Image options

For information about options specified in Setup, see Configuration and Setup.

Option Information

Halftone Simulation Specify a halftone screening method for your print job.

Select Application Defined to use the screening set by the application.

Select Newsprint if you want a look similar to that of a newspaper.

Select User Defined 1-3 to use the screening set by the EX8002. The User Defined Screen 1-3 settings 
reflect the setting specified in EX8002 Setup.

For more information, see Fiery Graphic Arts Package.

Image Smoothing Select On to minimize grainy output when printing low-resolution images.

Brightness Select 85% for a substantially lighter image, 115% for a substantially darker image, or use one of the 
settings in between.

Text/Graphics Enhancement Specify if you want to sharpen the appearance of text or vector graphics.

Image Quality Specify the type of image quality for the job.

The Image Quality option affects the fineness of images in the job; there is a trade-off with processing 
speed.

Digital Press Mode Specify to select the different screens that are available on the digital press when printing a job.

Specify Defined by Output Profile for the EX8002 to look at the calibration set associated with the 
output profile set for a job. The EX8002 will use the Digital Press Mode setting that is associated with 
that calibration set. This ensures that the screen applied during calibration is the same screen applied 
for the job, and that the calibration adjustment will be accurate.

NOTE: For Mixed Media jobs, the Digital Press Mode is automatically set to 200 Dot Rotated.

Text/Graphics Quality Use this option to enhance the resolution of text and graphics.

Select Normal to provide a good quality, sharpened image at high print speed.

Select Best for higher resolution and more sharpened output quality, which may affect printing speed.
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Finishing options

Option Information

Page Order Select From 1-N to print the pages of your job from first to last.

Select From N-1 to print the pages of your job from last to first.

Collation Specify how to output multiple-page/multiple-copy jobs.

For more information, see page 91.

Face-Down Printing Select On to print your document on the bottom of the sheet of paper (the document outputs from 
the digital press with the text facing down).

Select Off to print your document on the top of the sheet of paper.

Stapler Mode Specify whether and how to staple the job.

Output Destination Specify the output location of the printed job.

NOTE: When you choose AutoSelect, print jobs are output to the top tray closest to the digital press.

HCS stands for “High Capacity Stacker”; CSS for “Common Stacker Stapler”; AOS for “Auto Output 
Switching”.

Certain output trays are optional and require installation. For information about installable options, 
see printer driver Help.

Offset Jobs Specify that different print jobs be offset in the digital press tray.

DFA Finishing Specify functional modes of your DFA device.

For information, see the documentation that accompanies the DFA device.

DFA Profile Specify a profile to control your DFA device behavior.

The profiles must be programmed at the digital press.

For information, see the documentation that accompanies the digital press and DFA device.

Image Shift Adjust an image for duplex printing by shifting the image horizontally, in the direction of paper travel, 
relative to the leading edge.

For more information, see page 95.
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Variable Data Printing (VDP) options

The EX8002 is compatible with the following variable data printing languages: 

• FreeForm and FreeForm 2 

• Personalized Print Markup Language (PPML)

• Creo Variable Print Specification (VPS)

• Xerox Variable Data Intelligent PostScript Printware (VIPP)

When creating VDP documents, the following settings for the master document and variable 
document must match: 

• Color Mode (Mac OS) or Print Mode (Windows) 

• Combine Separations

• Duplex

• Orientation 

• Page Size 

• Stapler Mode

The following setting for the variable document overrides the corresponding settings in the 
master document:

• Media Type

• Page Order

• Paper Source

Option Information

FreeForm: Create Master To create a FreeForm master from this job, specify a number to assign to the FreeForm master file.

Command WorkStation allows you to select up to 100 FreeForm Masters.

For more information, see Variable Data Printing.

FreeForm: Use Master For variable data print jobs, specify a FreeForm master number to be used for the job.

Command Workstation allows you to select up to 100 FreeForm Masters.

For more information, see Variable Data Printing.

FreeForm: Preview Master Click to generate a low-resolution image of your master page.
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Stamping/Watermark options

Print Master Use this option to verify or confirm your Master page.

For more information, see Variable Data Printing.

Printer’s default reflects the setting specified in EX8002 Setup.

Remove White PPT Background Select On when using PowerPoint to create variable data in conjunction with FreeForm.

File Search Path Some PPML and other types of jobs do not contain all of the variable data job resources in a single file. 
In these cases, on a job per job basis, specify the location of the variable data job external resources so 
that the EX8002 can access them.

For more information, see Variable Data Printing.

Pages Per Record Use this option to define record-based (rather than job-based) finishing, based on the number entered.

This option is used with the Define Record Length option. 

For more information, see Variable Data Printing.

Define Record length This feature allows you to process a PDF or PostScript file like a variable data print job, and to apply 
record-based finishing. 

This option is used in connection with the Pages Per Record option.

For more information, see Variable Data Printing.

Use PDF XObjects Specify On to use PDF XObjects, a feature that recognizes objects (text, images, vectors) within a 
PostScript or PDF file and caches the image, reducing need to reRIP (re-process) image data for faster 
printing.

For more information, see Variable Data Printing.

This option is only accessible from Command WorkStation.

Option Information

Option Information

Watermarks Select standard text for your watermark from the pull-down menu. 

To create your own watermark, click New.

To modify a standard watermark, select from the pull-down menu and click Edit.

To remove a watermark from the list, select from the pull-down menu and click Delete.

For more information about using watermarks, see printer driver Help.

Print Watermarks: First Page 
Only 

Use this option print watermarks on only the first page. For more information about using 
watermarks, see printer driver Help.
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Overriding print option settings
Print option settings that were specified in the printer driver can be overridden in Command 
WorkStation Job Properties.

TO OVERRIDE JOB PROPERTIES

1 In Command WorkStation, right-click a held job in the Active Jobs queue.

2 Choose Properties from the pop-up menu.

3 Specify the number of copies to print, and then click Print.

You can override most print options in the printer driver and Command WorkStation Job 
Properties. Exceptions are listed in the following table: 

Printer driver tab Option Driver 
Win

CWS 
Win

Driver 
Mac

CWS 
Mac

JOB INFO Print Range x x

Print Queue Action x x

User Authentication: Username x x

User Authentication: Password x x

User Authentication: Use Windows Login x

User Authentication: Save User Information x

User Authentication: I’m a Guest x

MEDIA Document Size x x

LAYOUT: Normal Mirror x

Orientation x x

Rotate 180 (check box) x x

LAYOUT: Booklet Paper size: Document size x

LAYOUT: Gang-up Document size x

Orientation x

EXPERT SETTINGS Use PDF/X Output Intent x x

VARIABLE DATA PRINTING FreeForm: Preview Master x x

Use PDF XObjects x x

STAMPING/WATERMARK Watermarks x x x

Print Watermarks: First Page Only x x x
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Additional information
The following sections provide additional information about print options. For more 
information about options, see the tables that begins on page 70.

Auto Trapping

Trapping is a technique to print some objects slightly larger or smaller than specified in an 
application, in order to prevent white edges around the objects. These white edges, or “halos,” 
can be caused by factors such as misregistration, the physical properties of the toners, and the 
stiffness of the media. The Auto Trapping feature provides you with advanced trapping 
settings and gives you full control over their values. For more information, see Color Printing.

Booklet Maker

Booklet Maker is the imposition tool that allows you to quickly print documents in booklet 
format, without the need for more involved page imposition programs. Booklet Maker 
provides advanced settings, while streamlining the booklet-making process by displaying only 
the options and controls relevant to your selections. Booklet Maker is capable of imposing 
jobs from nearly any application.

Booklet Maker can be accessed in the printer driver when you print a job or in Command 
WorkStation Job Properties, where you can modify a job’s properties.

NOTE: Mixed media jobs, and variable data jobs are not supported when using Booklet 
Maker.
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The following booklet layouts are available:

Saddle binding: In Saddle binding, signatures are folded together as a group, and then stapled 
or stitched along the center fold, which forms the spine of the booklet. 

Nested Saddle: The Nested Saddle binding method combines saddle and perfect binding 
methods by stacking two or more saddles (also called “groups” or “subsets”) together 
along the common fold, then gluing them together at the fold to form the spine.

Perfect binding: In Perfect binding, separate folded pages are printed and stacked in 
booklet order. Finished pages are stitched adjacent to one another for trimming or gluing.

For Booklet Maker options and available settings, see the table that begins on page 76.

For information about using Booklet Maker options, see Booklet Maker Help.

Saddle (left) binding Saddle (right) binding

1

Saddle (top) booklet

1 1

Nested Saddle 
(left) binding

Nested Saddle 
(right) binding

Nested Saddle 
(top) binding

Front Back Perfect booklet
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TO ACCESS BOOKLET MAKER FROM THE WINDOWS PRINTER DRIVER

1 In your application, choose File > Print.

2 Select the EX8002 as your digital press, and then click Properties.

3 In the printer driver, click the Layout icon, select the Booklet option, and then click Settings.

TO ACCESS BOOKLET MAKER FROM THE MAC OS X PRINTER DRIVER

1 In your application, choose File > Print.

2 Select the EX8002 as your digital press, and then choose Fiery Features from the drop-down 
list.

3 Click Full Properties in the Quick Access pane.

4 In the printer driver, click the Layout icon, select the Booklet option, and then click Settings.

TO ACCESS BOOKLET MAKER FROM COMMAND WORKSTATION

1 Double-click your print job in the Active Jobs window; or right-click the job and select 
Properties from pull-down menu.

2 Select the Layout icon in the Job Properties window.

3 Select the Booklet option, and then click Settings.

Collation

Use this option to specify sorting options.

Collated: Copies of a complete job are sorted as 1-N, 1-N.

Uncollated: Copies of a complete job are sorted as 1,1, 2,2, 3,3.

NOTE: The Collation of Mixed Media and Variable Data Printing (VDP) jobs is handled 
differently. For mixed media jobs, copies of a complete job are sorted according to finishing 
set. For variable data printing jobs, copies of a complete job are sorted per record.

For more information about VDP, see Variable Data Printing; and for information about 
Mixed Media, see Utilities.
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Document size and Paper size 

Document size is the page size defined in your application’s Print setup (or Page setup) dialog 
box. Paper size is the size of the actual sheet of paper on which your job is printed. It may be 
useful to think of Document size as digital input (the page size defined in your original 
document) and Paper size as the physical output (the actual size of the paper in the digital 
press tray).

In cases when you print one document page per sheet of paper, Document size is usually the 
same as the Paper size. However, Document size may differ from Paper size when you print 
booklets or impose multiple document pages on a single sheet. 

The following illustrations show examples of possible relationships between Document size 
and Paper size. Note that the orientation of all pages shown is Landscape.

Document size may also differ from Paper size when using the Scale or Scale to Fit options. 
The Scale option reduces or enlarges the document page at a specified percent. The Scale to 
Fit option automatically reduces or enlarges the document image to fit the selected Paper size. 

For information about Scale and Scale to Fit, see page 99.

For information about Document size and Paper size in booklet printing, see Booklet Maker 
Help.

Document size (input) Paper size (output)

Document size is the 
same as Paper size.
Scaling is 100%.

Letter Letter

Tabloid Document size scaled 
to fit on Letter Paper size. 
Scaling is 50%.

Tabloid 11x17 Letter

A4 Document size scaled to 
fit on A3 Paper size.
Scaling is 141%.

A4 A3

A A
A A

A A
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Duplex printing

TO PRINT DUPLEX (DOUBLE-SIDED) PAGES

1 In your application, choose File > Print and do one of the following.

Mac OS X: Select the EX8002 as your digital press, choose Fiery Features from the drop-down 
list, click Full Properties in the Quick Access pane, and then select Normal on the Layout tab.

Windows: Select the EX8002 as your digital press, click Properties, click the Layout icon, and 
then select Normal.

2 Choose one of the Duplex settings:

Head to Head: Prints the top of the image on Side 1 on the same edge of the page as the top of 
the image on Side 2.

Head to Toe: Prints the top of the image on Side 1 on the opposite edge of the page from the 
top of the image on Side 2.

The following table shows how the Duplex settings correspond to printed output. 

3 Print the job.

Head to Head Head to Toe

Portrait

Landscape

1 2 1
2

1 2 1

2
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Gang-up printing

The EX8002 includes two speed-printing options: 

Step & repeat: Select this option to speed print a job so that the first page of your document 
is printed twice on the first sheet. The next sheet duplicates the data on the second page, the 
next sheet duplicates the data on the third page, and so on. When the printed sheets are cut in 
half, the result is two complete sets of the same document.  

Cut & stack: Select this option to speed print a job so that when the sheets are stacked and cut 
from the central position, the job is numbered in order and separated as two stacks. The print 
order is such that when the sheets are cut in half, you can combine them to form a single 
complete set of the document, in faster printing time.

For available options and settings, see the table on page 79.

TO ACCESS GANG-UP PRINT FROM WINDOWS PRINTER DRIVER

1 In your application, choose File > Print.

2 Select the EX8002 as your digital press and click Properties.

3 In the printer driver, click the Layout icon, select Gang-up print, and then click Settings.

TO ACCESS GANG-UP PRINT FROM MAC OS X PRINTER DRIVER

1 In your application, choose File > Print.

2 Select the EX8002 as your digital press and choose Fiery Features from the drop-down list.

3 Click Full Properties in the Quick Access pane.

4 In the printer driver, click the Layout icon, select Gang-up Print, and then click Settings.

Front only Front Back

Single-sided Duplex (double-sided)

Front only Front Back

Single-sided Duplex (double-sided)
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Image Shift

Image Shift allows you to specify how much the image on each page should be shifted relative 
to the X (horizontal) and Y (vertical) axis. Moving the job content in this manner enables you 
to allow for various finishing options, such as stapling and binding. Image Shift prevents the 
image from being clipped.

NOTE: This option is available in the printer drivers or Command WorkStation. 

NOTE: This option is effective only for jobs in which Pages per sheet is set to 1-up.

TO DEFINE IMAGE SHIFT FOR A PRINT JOB

1 In your application, choose File > Print and do one of the following.

Mac OS X: Select the EX8002 as your digital press, choose Fiery Features from the drop-down 
list, click Full Properties in the Quick Access pane, and then click the Finishing tab.

Windows: Select the EX8002 as your digital press, click Properties, and then click the 
Finishing icon.

2 Mac OS X: Enable Image Shift. 

Windows: Enable Image Shift and then click Image Shift Options.

3 Select the units of measurement.

4 Type the Front and Back image shift settings in the X and Y axis fields. You can also use the 
arrow buttons to shift the image settings.

NOTE: The maximum value for both X and Y axes is 999.99 points/13.89 inches/352.77 mm.

5 To align front and back images proportionately, select Align front and back images.

6 Click OK.
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Mixed Media

The Mixed Media feature allows you to define the chapter divisions of a print job and to print 
certain pages, or ranges of pages, on varying types of medias. For example, you can use this 
option to add blank pages or to specify duplex pages within a single print job. You can also 
use Mixed Media to specify chapter-based finishing options, which treat each chapter as a 
separate finishing or duplexing set.

You can access Mixed Media from Command WorkStation or the printer driver. Instructions 
for accessing and using Mixed Media are provided in the Command WorkStation online 
Help. Features specific to the EX8002 are described in Utilities.

The following procedure describes how to access and print using Mixed Media from the 
printer drivers.

TO ACCESS MIXED MEDIA FROM THE PRINTER DRIVER

1 Select Print from your application, and click Properties.

Mac OS X: Select the EX8002 as your digital press, choose Fiery Features from the drop-down 
list, click Full Properties in the Quick Access pane, and then click the Media icon.

Windows: Select the EX8002 as your digital press, click Properties, and then click the Media 
icon.

2 Select Media from the Fiery Printing tab, and then click Mixed Media Define.

The Mixed Media dialog box appears. 
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3 Select from the following options:

Chapter Start Page(s): Use this option to designate chapter divisions, using comma-separated 
values (for example: 4,9,17) to designate the start of each new chapter. 

NOTE: It is not necessary to type the first page; page numbers refer to the numbering of the 
original document. 

Define Each Chapter As A Separate Finishing Set: Select this option to apply finishing options 
(such as stapling) or double-sided printing to each chapter created with the Chapter Start 
Page(s) option. For double-sided printing, using this option forces each starting page to use a 
right-side page, adding a preceding left-sided blank, if necessary.

NOTE: If you use the Chapter Start Page(s), Define Cover, or Define Each Chapter As A 
Finishing Set, all media specified in the Paper Size per chapter must share the same 
dimensions (for example, all Letter, all Tabloid, or all A4).

Define Cover: Use this option to assign page attributes (Color Mode, Cover Page Mode, 
Duplex, Media Type, Paper Size, Paper Source, Paper Catalog, and Tab Shift) to front and 
back cover pages.

Define Page Range: Use this option to assign page attributes (Color Mode, Duplex, Media 
Type, Paper Size, Paper Source, Paper Catalog, and Tab Shift) to specific pages, or ranges of 
pages. After you set page attributes, select Add Definition to save your settings. 

Insert Blank: Use this option to assign page attributes (Media Type, Paper Size, Paper Source, 
and Paper Catalog) to blank pages. 

4 After you set page attributes, click Add Definition (for Page Range) or Insert (for Blank 
pages).

5 Click OK.

NOTE: You can save up to 100 different settings for the Selection List in the Mixed Media 
dialog box.

The way you define Mixed Media in the Windows and Mac OS X printer drivers is similar to 
the way you define it in Command WorkStation. For more information and detailed 
procedures, see Utilities.
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Paper Catalog

Paper Catalog is a system-based paper warehouse database that stores the attributes of any 
media that is available for printing from the EX8002. After the media types have been added 
at the digital press control panel, you can select media from those listed for your job.

The following procedure describes how to access Paper Catalog from the printer driver.

TO ACCESS PAPER CATALOG FROM THE PRINTER DRIVER

1 Establish Two-Way Communication between your computer and the EX8002 by entering the 
IP Address or DNS name in Properties.

For information about establishing Two-Way Communication, see printer driver Help.

2 Select Print from your application and click Properties.

3 Click the Media tab and select the required media from the Paper Catalog pull-down menu.

4 Click Select Media to view the entire database and the full descriptions of paper attributes.

For information about accessing Paper Catalog from Command WorkStation and Hot 
Folders, see Utilities.

Paper Source

The Paper Source option allows you to select a specific tray for your job. If you choose the 
AutoSelect setting, the digital press prints from any tray containing the paper size necessary 
for the job. This setting also allows the digital press to automatically switch between trays, if 
the current tray becomes empty, while continuing to print. 
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Scale

The operator can specify a scaling override in Command WorkStation, but the override is 
applied to any scaling value already set in the active job. For example, if a user sends a job 
with a scaling value of 50% and the operator specifies a Scale override of 300%, the job is 
printed at 150% of the original document size, that is, 50% of 300%.

Scale to Fit

The Scale to Fit option allows you to scale a job to a Paper size different from the Document 
size. When you set this option to On, the image is increased or reduced in size to fit the paper 
size you select from the Paper Size menu. When you set this option to Off, the original 
document size is printed without any scaling, even if you select a larger paper size.

Document size
Letter

Paper size
11 x17

Scale to Fit set to On

Scale to Fit set to Off
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User Authentication

If user authentication has been enabled in the EX8002 setup, you must enter a valid user 
name and password to send a print job to the EX8002. In Command WorkStation, the 
management of jobs is determined by how you have logged on to the EX8002.

For Mac OS X: Select the Job Info icon and type logon information in the User Name and 
Password fields. 

Use Windows Login: Choose this option if you are already logged on to a Windows computer. 
Otherwise, type your Windows network logon information in the Username and Password 
fields.

Save User Information: Select this option to save Windows logon information. By default, 
this option is activated.

Validate: Click to validate user authorization and to confirm printing privileges. To validate, 
Two-Way Communication must to be activated. For information on establishing Two-Way 
Communication, see printer driver Help.

I’m a guest: Choose this option to activate guest printing privileges. By default, guest printing 
is permitted.

For information about enabling user authentication in the Configure WebTool, see 
Configuration and Setup.

For information about the digital press’s user authentication, see the documentation that 
accompanies your digital press.
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Numerics
2-Color Print Mapping option 80

A
AppleTalk connection, Mac OS X 16, 20
Auto Trapping option 80, 89

B
binding method 76
Black Overprint option 81
Black Text/Graphics option 81
Booklet Maker

Align pages option 77
Back Cover option 78
binding method 76
Booklet Cover Source option 78
Cover Content option 77
Cover is prepared for the booklet 76
Cover Media option 78
Creep compensation 77
Document size 76
Front Cover option 78
Gutter option 77
Increase gutter by option 77
Nested Saddle booklets 90
Page Alignment 77
Paper size 76, 79
Shrink to fit option 77

Booklet option 89
Booklet printing 75
Booklet type, binding method 76
Brightness option 84

C
CMYK Simulation Method option 81
CMYK Simulation Profile option 81
Collation option 85, 91
Color mode see Print mode
Color print options

setting 27
Color Setup, job overrides 69
Combine Separations option 80
Command WorkStation, printing files from 21

Composite Overprint option 80
Control Bar 72
Copies option 71
Cover Content Input option 77
Cover Media option 78
Create Master option 86
Creep compensation 77
custom page size, see defining a custom page size, 

printing a custom page size

D
Default Browser connection 14, 18
default print options 24, 57
Define Record Length 87
defining a custom page size, Windows 59
defining Image Shift 95
DFA Finishing option 85
DFA Profile option 85
Digital Press Mode option 84
Docs tab in WebTools 21, 52
Document Size option 73, 88
Downloads tab in WebTools 11, 36
Duplex (double-sided) option 75, 79, 93
duplex printing see Duplex (double-sided) option

E
E-mail Service

about 62
Manage print jobs 65

Expert Color mode see Print mode
Expert Color Settings dialog box 28

F
Face-Down Printing option 85
Fiery Features 25
File port, saving files to 59
File Search Path 87
FreeForm

Create Master option 86
Preview Master option 86, 88
Print Master option 87
Use Master option 86

FTP Printing 67

INDEX
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G
Gang-up print

Cut & stack 94
Document size 79
Gang-up type 79
Gutter option 79
Increase gutter by option 79
Orientation 79
Shrink to fit option 79
Step & repeat 94

Gang-up printing 75
Gang-up type 79
Grayscale mode see Print mode
gutters 77, 79

H
Halftone Simulation 84
Hot Folders 21

job overrides 69

I
I’m a Guest 71, 88, 100
Image Quality option 84
Image Shift option 85
Image Shift, defining 95
Image Shift, setting options 29
Image Smoothing option 84
installing

Job Monitor 61
printer driver from User Software DVD 38
printer drivers from server 37
printer drivers using Point and Print 33
virtual printers using Point and Print 41

installing printer drivers 12
Instructions field 27, 71
IP Printer connection 15, 19
IPP connection 49

J
Job Info icon 54
Job Monitor

configuring connection 61
installing 61
on User Software DVD 9
using 61

job overrides
2-Color Print Mapping option 80
Auto Trapping option 80
Black Overprint option 81
Black Text/Graphics option 81
Brightness option 84
CMYK Simulation Method option 81
CMYK Simulation Profile option 81
Collation option 85
Combine Separations option 80
Composite Overprint option 80
DFA Finishing option 85
DFA Profile option 85
Digital Press Mode option 84
Face-Down Printing option 85
Image Quality option 84
Image Shift option 85
Image Smoothing option 84
Media Type option 74
Offset Jobs option 85
Output Destination option 85
Page Order option 85
Paper Simulation option 81
Paper Size option 92
Print Queue Action option 71, 88
print settings 69
Rendering Style option 82
RGB Separation option 82
RGB Source Profile option 82
Save User Information option 71, 88
Scale to Fit option 75
Schedule Printing option 71
Stapler Mode option 85
Substitute Colors option 80
Text/Graphics Enhancement option 84
Tray Alignment option 74
Use PDF/X Output Intent 83
Use Windows Login option 71, 88

L
Language folders 10
Layout option see Pages per sheet
Line Printer Daemon - LPD 15, 19
LPR connection 46
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M
Mac OS X

AppleTalk connection 16, 20
Default Browser connection 14, 18
IP Printer connection 15, 19
Line Printer Daemon - LPD 15, 19
PPD 21
printer driver installation 10
printer driver setup 13
selecting printers 22

Mac OS X applications, printing from 21
Manage print jobs with e-mail commands 65
managing print jobs 65
Media Type option 74
Mirror option 75
Mixed Media 74, 96
Mixed Media, setting options 29

N
Nested Saddle booklets 90
Notes field 27, 54
Notes option 71

O
Offset Jobs option 85
Orientation option 75
OSX Installer 11, 21
Output Destination option 85
Output Profile option 81
overrides, of job settings 69
overriding Printer Setup settings 56

P
Page Order option 75, 85
Page Setup dialog box 24
Pages Per Record 87
Pages per sheet option 75
Paper Catalog 73, 98
Paper Simulation option 81
Paper Size option 73, 92
Paper Source option 73
Password 71, 88
Perfect booklet setting 90
Point and Print 33
Postflight 72
PostScript fonts 9
PostScript Printer Description file, see PPD
PostScript printer description files, see PPDs

PostScript printer driver
deleting 43
download using WebTools 36
installing from User Software DVD 38
installing using Point and Print 33

PostScript printer drivers, explained 68
PPD

Mac OS X 21
overview 9
Windows 39

PPDs (PostScript printer description files)
options 69

Preview Master option 86, 88
Print Border option 75
Print dialog box 24
Print Gray using Black Only (CMYK) option 82
Print Gray using Black Only (RGB) option 82
Print Master option 87
Print Mode 80
print options 53

in Full Properties of Quick Access 
window 26

setting 24
Print Queue Action option 71, 88
Print Range option 71
printer default settings, where to set 69
Printer Delete Utility 43

on User Software DVD 9
printer drivers

downloading with WebTools 12
installing 10
setting up 13

Printer Setup Utility 11
Printer’s default 56
printing

from an application 53
from Mac OS X applications 21
to File port 59
using an E-mail client 63

printing a custom page size, Windows 59
printing connections, supported types 44
Prntdrve.exe file 36
Progressives 72
Pure Black see Black Text/GRaphics

Q
Quick Access window, customizing 26
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R
Remove White PPT Background option 87
Rendering Style option 82
RGB Separation option 82
RGB Source Profile option 82
Rich Black see Black Text/Graphics
RIPping 68

S
Save User Information option 71, 88, 100
Scale option 75, 99
Scale to Fit option 75, 99
Schedule Printing option 71
selecting printers, Mac OS X 22
Shrink to fit 77, 79
SMB printing

completing connection 45
setup 34

speed printing see Gang-up print
Spot Color Matching option 83
Standard Booklet setting 90
Stapler Mode option 85
Step & repeat 94
Substitute Colors option 80

T
TCP/IP connection 46
Text/Graphics Enhancement option 84
Text/Graphics Quality option 84
Tray Alignment option 74
Two-Way Communication 55

U
USB device 66

automatic printing 66
printing files from 66

Use Master option 86
Use PDF XObject 87, 88
Use PDF/X Output Intent 83
Use Windows Login 100
Use Windows Login option 71, 88

User Authentication 54, 100
for Mac OS 100
I’m a Guest 100
Password 100
Password option 71, 88
password option 26
Save User Information option 71, 88, 100
Use Windows Login 100
Use Windows Login option 71, 88
user name option 26
Username 100
Username option 71, 88

User Software DVD, installing printer driver files 
from 10

Username option 71, 88

V
Variable Data Printing

Define Record Length 87
Pages Per Record 87

Variable Data Printing (VDP)
Create Master option 86
Preview Master option 86, 87, 88
Use Master option 86
Use PDF XObjects 87, 88

virtual printers
installing using Point and Print 41
setting up 41

W
Watermarks option 87

First Page Only setting 87
WebTools

Docs tab 21, 52
Downloads tab 11, 36

Windows
IPP connection 49
LPR or Port 9100 connection 46
printer driver, installing from User Software 

DVD 38
TCP/IP connection 46
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